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GRAPHICS FOR FLAG DESIGN                           (from newzealand.flagoptions.com)
(An abbreviated version of this document was originally ADDENDUM SIX to a PDF entitled “Good Flag, Bad Flag is Rubbish”)

In the second section of the denouncement to which this addendum has been attached,
it was observed that the process of finding and selecting symbols to incorporate in a
flag design will essentially be a research project.  The process of actually  designing a
flag, on the other hand, after most or all of its potential symbols have been gathered
together, will essentially be a graphics project.  Flag designers who are conversant with
one or more computer graphics programs will have a tremendous advantage over those
who may naively think that they can get by with ordinary manual drafting equipment,
or even worse (far, far worse), with just a ruler, a compass, and some coloured pencils.

Yet that latter option is actually the only one that the author of “Good Flag, Bad Flag”
has ever recommended to flag designers, revealing yet another facet of his charlatanry.
To be specific, he has suggested that a flag should be designed on a small piece of paper
that has the approximate dimensions of a wide postal stamp, or in his parlance,  “one
inch by 1.5 inches” (about 2.5 cm by 3.8 cm).  He explains his suggestion by adding:
“Realistically, that’s how people will be seeing it as it flaps from a flagpole 30 metres
away.”  Just to be clear, he does not offer this sage recommendation within the pages
of his pamphlet, but in his other writings and in his occasional dog-and-pony shows.
Other so-called flag design experts, including Roman Mars, who has become GFBF's
sycophant-in-chief, have offered the same advice.  Mars has gone so far as to provide a
clarifying illustration on one of his websites, as shown to the left below, where he not
only repeats the daft idea itself, but its obvious bias towards a 2:3 dimensional ratio.

Presumably one would enter such a design into a flag
contest by submitting it in the form of a zoomed and
cropped photograph.  Of course, no properly run flag
contest  would accept  such an entry.   As the  reader
may  know,  the  New  Zealand  Flag  Referendums  of
2015-2016 allowed them, but that unhappy endeavour
cannot be characterised as having been 'properly run'.

Although a flag of practically any dimensions, waving thirty metres away, can certainly
be visually occluded by a postal stamp held at a certain distance from an observer's eye,
and although it is nice to know how a waving flag might appear from such a distance,
the idea of forcing a flag design into simplicity by shackling it to a tiny design area has
no merit, since   great flags are not limited to those that have simple designs  .
There is nothing wrong with using paper and coloured pencils to experiment with flag
design ideas in their nascent stages, and some flag designers prefer to work in that way.
In the early days of personal computer systems, designers often did not need to go any
further,  as was the case for Frederick Brownell in 1994, when he designed the flag of
South Africa.  Yet the paper on which Brownell experimented was never stamp-sized.

Flags should not be designed on pieces of paper that are the size of wide postal stamps.
They should instead be designed as postal stamps themselves are now designed, on the
large screens of computer monitors.  Moreover, flag designers should be free to include
as much complexity in their designs as stamp designers are free to include in theirs.
Readers are asked to consider some of the beautifully complex stamps that they have
seen in  their  lifetimes.   Would they characterise  their  experiences  of  viewing such
stamps, to borrow a bit of hyperbole from the author of GFBF, as being 'overwhelmed'?
Have they found the numerous colours that are often seen in such stamps 'hard to
distinguish'?  Have they ever felt that such stamps would have been 'better', had their
designs been 'simple enough for a child to draw from memory'?  Yes, stamps are flat,

https://flagoptions.com/
https://www.bbc.com/news/magazine-27155475
https://web.archive.org/web/20180915043022/https://flagoptions.com/wp-content/uploads/Mistakes-of-the-2015-2016-New-Zealand-Flag-Referendums.pdf
https://99percentinvisible.org/article/vexillology-revisited-fixing-worst-civic-flag-designs-america/
https://flagoptions.com/wp-content/uploads/Good-Flag-Bad-Flag-is-Rubbish.pdf
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and we do not observe them waving like flags, but on the other hand, every detail in a
flag that is waving at a distance will be assimilated in the mind of an observer after only
a few moments of the flag's waving.  In effect, a distantly-waving flag will be 'flattened'
by the 'mind's eye', making the viewing of a distantly-waving, complexly-designed flag
essentially the same as viewing a flat, complexly-designed stamp, held at arm's length.

Having addressed the witless approach to graphics that the author of GFBF advocates,
this  addendum  can  focus  on  its  more  pleasant  purposes.   As  implied  by  its  first
paragraph, its premise is that aspiring flag designers should use graphics software to
design their flags.  It is intended for those who have not yet scaled the learning curve of
such software, and who are open to advice about how they might best choose at least
one such learning curve to begin climbing.  Their climb needn't be arduous, nor should
it require more than a modest expense of time, because flag designers do not need to
ascend to the levels of professional graphics designers.  Moreover, their expense need
not be monetary at all, because all that they will require is freely available.  They only
need to make an informed choice, and this addendum intends to help them make one.
In flag design,  as in so many other endeavours,  the best  way to learn is  by doing.
Moreover, the time to learn how to use graphics software is long before a flag contest
or some other event presents an opportunity to design a flag, so make a start, mate.

Computer graphics programs can create and process two basic categories of graphic
images, both of which are relevant to flag design, and each of which can be saved in a
number  of  different  computer  file  formats.   One  of  the  two  basic  graphic  image
categories is called 'raster', which can also be called 'bitmap'.  The other basic graphic
image category is  called 'vector'.   Flag designers can work with raster images,  with
vector images, or with a combination of the two.  Neither will be extensively explained
here.  Readers who are not already aware of the basic properties of raster and vector
imaging are expected to inform themselves by means of Internet searches.  Some of the
best results for such searches may be provided by graphics software producers such as
Adobe, who may sprinkle references to their  own proprietary products within their
explanations, as indeed Adobe does in its thorough and well-organised descriptions of
raster files, of vector files, and of how they differ.  Several other graphics-related terms
have become fairly uniform across different graphics software programs, and many of
these standard terms have been assembled into lists both here and here, where Adobe
has accompanied each of the terms with a helpful visual explanation.

For the novice, raster imaging software may offer a quicker and easier learning curve,
at least to the level of proficiency required for flag design.  The menu of free software
that is available is also longer, and the useful and enjoyable things that one can do with
raster imaging software besides designing flags are innumerable.  Anyone who wants to
manipulate digital photographs and videos, for example, will find raster software the
only way to go.  Raster images can be stored and manipulated in file formats that retain
a maximum amount of image detail, and which accordingly require larger file sizes.
These are called lossless or 'uncompressed' file formats, and they should be used for
every  stage  of  designing  a  raster  image  flag,  whether  they  are  proprietary  to  the
graphics software being used or they are one of several conventional lossless formats.
When flag designs are presented on Web pages, however, they will generally need to be
converted  to  more  lossy  or  'compressed'  raster  image file  formats  that  have  much
smaller file sizes.  Flag designers working with raster images will accordingly need to
understand  such  things  as  anti-aliasing  and  pixel  density,  often  improperly  called
resolution, as well as bit depth, which can also be called colour depth or colour count.
Bit depth also applies to vector images.  Explanations for these terms will follow later.

https://web.archive.org/web/20220208023844/https://helpx.adobe.com/photoshop/key-concepts.html
https://web.archive.org/web/20210425065021/https://helpx.adobe.com/photoshop-elements/key-concepts.html
https://web.archive.org/web/20220217015024/https://www.adobe.com/creativecloud/file-types/image/comparison/raster-vs-vector.html
https://web.archive.org/web/20220129201632/https://www.adobe.com/creativecloud/file-types/image/vector.html
https://web.archive.org/web/20220129201554/https://www.adobe.com/creativecloud/file-types/image/raster.html
https://en.wikipedia.org/wiki/Graphics_software
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One of the advantages that vector image files will usually have over comparable raster
image files is their smaller file sizes, making them more 'polite' about the space that
they will need to use on storage drives, including the drives of website servers.  The
chief advantage of vector imaging software, however, is that the files it produces are
ready, just as they are, to be transformed into actual flags by manufacturers, because
the edges of such images will remain razor-sharp, no matter the sizes to which they are
scaled.  The novice flag designer may therefore prefer to pick a vector software learning
curve, even though their climb is apt to be somewhat more difficult and lengthy than
for a raster route.  Vector software will not help them with ordinary photos and videos,
but otherwise there will be no drawbacks to choosing vector.  For the purposes of such
things as Web page presentations and flag contest entries, almost all vector graphics
programs can save or export vector image files as compressed, raster image files.  

On the other hand, although vector imaging software can directly produce flag designs
in the file formats that are required for manufacture, this is not really the disadvantage
that it may seem for raster image files, which can always be converted to vector image
files, albeit with somewhat more effort than is required by conversions in the vector-to-
raster direction.  Some flag manufacturers even offer a free service to convert raster
image files into the vector image files that they will need for producing actual flags.
The upshot is that raster software users need not be overly concerned about this issue. 

There  are  an  intimidating  number  of  raster  image  file  formats,  but  except  for  the
uncompressed, proprietary image format of whatever raster image software is chosen,
the two formats that will  arguably be the most useful for flag designers are (1) the
uncompressed Portable Network Graphic (PNG/.png) format and (2) the compressed
Joint  Photographic  Experts  Group  (JPEG/.jpg)  format,  although  the  highly-
compressed Graphics Interchange Format (GIF/.gif) may also have its occasional uses.

There  are  also  a  plethora  of  vector  image  file  formats,  but  again,  except  for  the
proprietary image format of the chosen graphics software, there are really only a few
vector image formats that are 'all that', or possibly even only two, when push comes to
shove,  which  are  (1)  the  Scalable  Vector  Graphics  (SVG/.svg)  format  and  (2)  the
Portable Document Format (PDF/.pdf).

Some readers may quibble that there is a third category of graphics image file formats,
the variety of which are also numerous, namely  3D image file formats, but since 3D
imaging is really just a specialised use of vector imaging, and sometimes even one of
raster imaging, and since one will struggle to find a great deal of use for 3D imaging in
flag design, this will be the only place where this addendum will address such a nitpick.

Graphics software noobs who are tempted to dive into the raster imaging pool may at
first be intimidated by the long list of raster imaging software that is available.  Those
who think that they can simply 'cut through the clutter' by spending money on a high-
end proprietary  graphics  software  product  may find  to  their  chagrin  that  they  are
confronted with software that has fantastic capabilities, but one that is accordingly so
bloated, cluttered, and user-unfriendly as to encourage them to not even try to learn
how to use it for the relatively simple task of designing a flag.  Thankfully, there are
some well-known raster graphics software products that are not only more suited to
the task of designing a flag than, say, Adobe Photoshop, but that are also free to use.
An Internet search for 'best free raster graphics software' is bound to mention GIMP,
which can be used on Windows, Apple, Linux, and even other systems, but although its
use will not put a monthly Adobe charge on one's credit card, its learning curve is not a

https://www.gimp.org/
https://en.wikipedia.org/wiki/Comparison_of_raster_graphics_editors
https://fileinfo.com/filetypes/3d_image
https://fileinfo.com/filetypes/vector_image
https://fileinfo.com/filetypes/raster_image
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particularly gentle one, because it essentially aims to be a Photoshop replacement, so it
is accoutred with some of the same drawbacks as that product.  Should one instead
search  the  Internet  for  'best  free  raster  graphics  software  for  beginners',  one  may
discover some  free products that are more suited to novices, but which may also be
platform-limited, such as  Paint.NET (Windows only).  Your best approach may be to
install several such free programs, to dabble with each of them, and to primarily settle
on the one that seems to be most suited to the needs of flag design, although you may
inevitably find your needs changing as you become more proficient, so you may have to
'jump ship' a few times to find a product that  really suits most or all of your needs.
Much more on that later.

Graphics software novices who decide to work with vector imaging software will soon
find that one of the most often recommended free alternatives to the pricey Adobe
Illustrator is Inkscape, which like its raster counterpart GIMP can run on many system
platforms,  and  which  also  like  GIMP  may  not  be  the  easiest  software  to  master.
Another free vector graphics editor that has a lot going for it  is  Libre Office Draw,
which  like  Inkscape  is  available  for  multiple  platforms.   Several  other  free  vector
imaging  editors  are  listed  here and  here.   Free  vector  software  that  is  tailored  to
beginners cannot always be downloaded for stand-alone installation, and must instead
be used online, or largely so, as is apparently the case for Vectr.  Whether vector editors
are stand-alone or online-only, a basic familiarity with at least a few of them may offer
some advantages.  Certain programs are more robust than others in their abilities to
open, save, or convert particular vector file formats, for example, so one might very
well want to keep such programs around, just for those express purposes.  Of course
there is nothing to prevent one from owning and using both vector and raster graphics
software  programs,  especially  since  both  sorts  are  freely  available,  and  there  is
something to be said for being able to work with both of the basic image file formats.

Searches on the Internet are bound to turn up reviews and Internet tutorials for most
or all of the graphics software that you decide to consider.  If you think that vector
software  will  be  your  cup  of  tea,  for  example,  you  may  want  to  check  out  this
Wikimedia Commons Inkscape tutorial, as well as those that Inkscape itself offers, or
perhaps Vectr's online tutorials, an expansion of which were being planned at the time
of this writing, according to this Web page.  If on the other hand you think that raster
software will suit you best, GIMP offers  a selection of tutorials, and Paint.NET is at
least  working on  some.   Whatever  graphics  software  you  contemplate,  appropriate
searches on YouTube may reward you with some very informative videos to watch.

In addition to all of the free graphics software with which one can actually design flags,
there are also a handful of other flag-design-related resources that are free, that may be
useful for flag designers, and that the author of this addendum would be remiss in
failing to mention.  For example, the online Scrontch's Flag Designer is worth a look,
regardless of how elementary it is, if for no other reason than its ability to open and to
save SVG files.  Somewhat more sophisticated is the online Flag Maker, a resource that
is provided by an actual flag manufacturer, and one that even includes a handful of
automated tutorials.  There are other flag manufacturers that offer similar, 'design your
flag here'  Web pages.   There  is  also a  free  NASA graphics  software  product  called

G.Projector, which at first glance might seem to have little
relevance to flag design, but which should perhaps not be
dismissed without a review of this document, or this one.
The use of G.Projector was instrumental, for example, in
the design of the speculative New Zealand flag shown left.

https://flagalternatives.com/wp-content/uploads/NASA-G.Projector-software.pdf
https://flagoptions.com/wp-content/uploads/NASA-G.Projector-software.pdf
https://www.giss.nasa.gov/tools/gprojector/
https://flagmaker-print.com/pages/flag-maker
https://flag-designer.appspot.com/#d=2&c1=2&c2=0&c3=7&o=5&c4=5&s=19&c5=6
https://www.gimp.org/tutorials/
https://vectr.com/tutorial.html
https://cdn.vectr.com/tutorials/getting-started-tutorial/
https://inkscape.org/learn/tutorials/
https://commons.wikimedia.org/wiki/Help:Vector_graphics_tutorial
https://commons.wikimedia.org/wiki/Help:Vector_graphics_tutorial
https://cdn.vectr.com/downloads/
https://www.maketecheasier.com/free-graphic-editor-for-creating-vector-image/
https://fixthephoto.com/best-free-vector-graphics-software.html
https://www.libreoffice.org/discover/draw/
https://inkscape.org/
https://en.wikipedia.org/wiki/Comparison_of_vector_graphics_editors
https://www.getpaint.net/
https://pathedits.com/blogs/tips/the-ultimate-raster-graphics-software-list-8-programs-to-consider
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Penultimately there is the online Flag Waver, which may be the most useful of all of the
freebies in the grab bag of items listed here.  Primarily the brainchild of a sharp young
coder called Joshua Koo, Flag Waver solves one of the biggest problems in flag design,
by giving flag designers, as well as viewers of flag designs, a
fair  idea of  how a  given flag will  actually  look when it  is
waving from a flagpole in a wind, or even when it is hanging
limply in a lack of wind, which are things that they might
otherwise be bad at visualising.  Lastly there are utilities that
are intended to ease the task of converting a raster graphics
image into a vector graphics image.  One of the best of them
may be Potrace, which can also be integrated into Inkscape.
Supposedly GIMP has raster-to-vector conversion capability
as well.  Whatever the vehicle, your kilometrage may vary.

Now, it is certainly not impossible to design a flag by using graphics software that is as
elementary as, say, the built-in Paint app that is included in Windows systems, or the
free  Paintbrush  app  that  is  available  for  Macs,  or  even  the  Drawing  app  that  is
automatically included in many Linux distros.  It is also not impossible to start a fire by
rubbing two sticks together.  What the simplest graphics programs generally lack are
features that allow for extensive revisions of flag designs, not only at first but in future.
To be specific, where graphics  editors for flag design are concerned, the feature that
separates the wheat from the chaff is the ability to design a flag in 'layers', which in
vector imaging may also be called 'groups'.  The layers and/or groups of any flag design
can be either raster in nature, vector in nature, or a combination of the two, and they
can be converted from one to the other.  They can be 'resized', 'merged' or 'flattened',
'grouped' or 'ungrouped', 'arranged' upwards or downwards, made 'hidden' or 'visible',
made  fully  or  partially  opaque,  translucent,  or  transparent,  'mirrored',  'flipped',
'rotated', changed in colour, and separately manipulated in countless ways.  The flag
that  is  designed  with  utterly  simple  software  is  dunzo,  and  it  will  be  difficult  or
impossible to revise, once it has been finished and saved, but one that is designed using
graphics  editing software that supports layers can be revised long  after it  is saved.
Instead of producing one-off flag designs, real graphics editors can produce flag design
projects, which can be returned to repeatedly until they reach ultimate refinement.

It  is  difficult  to overstate the power of  layers in designing
flags.   The concept of  layers is  second nature to seasoned
graphics designers, but it may not be immediately grasped
by novices, for whom an analogy may be helpful.  Beginners
are asked to consider certain booklets or book inserts that
they have probably seen, sometime in their lives, which use
illustrations on several pages of cellulose acetate, most often
to reveal human anatomy or the anatomy of other creatures.

Each page of acetate is transparent, other than for its particular full-colour illustration
and accompanying notes.  To reveal the wonders of human anatomy, for example, the
top acetate page or layer will typically depict the skin, and by turning successive pages
the underlying musculature, blood circulation, nervous system, internal organs, and
so-on will be illustrated, right down to a first or basic layer that will show the skeleton.

The starting point for any flag that one designs by using a graphics editor will be its
first layer, which can be thought of as the basic foundation of the design, or perhaps its
'skeleton', if we borrow from the analogy above.  This 'background' layer will generally
be called 'Layer 1' by default, but it can always be re-named more descriptively later on.

https://www.youtube.com/watch?v=9znPs2EB-pk
https://www.youtube.com/watch?v=h-MRH9r73I8
https://web.archive.org/web/20220127011750/https://en.wikipedia.org/wiki/Layers_(digital_image_editing)
http://potrace.sourceforge.net/
https://en.wikipedia.org/wiki/Comparison_of_raster-to-vector_conversion_software
https://en.wikipedia.org/wiki/Comparison_of_raster-to-vector_conversion_software
https://en.wikipedia.org/wiki/Comparison_of_raster-to-vector_conversion_software
https://github.com/zz85
https://krikienoid.github.io/flagwaver/
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Layer 1 of the 'image', 'project', or 'document', as a given graphics editing program may
refer to one's flag design, will be assigned a set of properties, either by default when the
program opens, as is the case for Inkscape, or on each occasion when the user begins a
'New' design from the program's menu.  Layer 1, like all subsequent layers, will always
be depicted as a rectangle.  This will not prevent the design of non-rectangular flags, as
long as they can 'fit' within the rectangular area that Layer 1 has defined.

The  most  basic  property  of  Layer  1  will  be  its  vertical  and horizontal  dimensions,
respectively corresponding to a flag's height and length.  As all flag designers should
know, a flag's 'dimensional ratio' is always expressed as the ratio of its height to its
width.  Thus the length of a 2:3 flag is 1.5 times its height, and the length of a 1:2 flag is
twice its height.  Designers who are interested in other possible flag dimensional ratios,
which are sometimes less accurately called aspect ratios, will find two dozen of them
shown in chart #15 on  the Flag Stories website, the incredibly informative charts of
which have all been made conveniently available as PDF files, here and here. 

Because of  a  single  powerful  nation that  has remained too dimwitted to adopt  the
metric system, most graphics editors will allow Layer 1 to be dimensioned in inches,
but sensible flag designers will opt for centimetres, or perhaps even for pixels, if they
are designing in raster.  It has become something of a convention for flag contests to
require the vertical dimension of submitted flag designs to be ten centimetres, which,
for the possible benefit of the Imperial-system-handicapped, is  the length of a ‘100s’
cigarette.  Thus the minimum vertical dimension of Layer 1 should be 10 cm, and the
corresponding minimum horizontal dimension of Layer 1 should be calculated from
the dimensional ratio of the flag that is being designed.  For a 2:3 flag, for example, the
minimum horizontal dimension of Layer 1 would be 15 cm, and for a 1:2 flag, it would
be  20 cm.   These  are  not  required dimensions  for  Layer  1,  because  a  flag  that  is
designed in layers with larger dimensions can always be resized for submission to a
contest, and also because larger dimensions may provide certain design benefits.  For
example, a 20 cm dimension will only be equally divisible by 2, 4, 5, or 10 cm, whereas
a 60 cm dimension will be equally divisible by 2, 3, 4, 5, 6, 10, 12, 15, 20, or 30 cm.
This  will  be less  of  an issue for  purely vector  designs,  which can always be  scaled
upwards when needed without any image degradation.  Purely raster designs, or those
that may use a combination of raster and vector imaging whilst they are being worked
on,  may  benefit  in  other  ways  from  larger  dimensional  work  areas,  such  as  the
essentially  equal  anti-aliasing  that  will  be  applied  to  the  overall  design  when it  is
reduced  to  contest-submission  size.   Yet  larger  design  layer  dimensions  will  also
require more system memory.   Designers  who do not want  to be plagued by error
messages such as 'insufficient memory to carry out the specified operation' are advised
to keep their layer dimensions reasonable, lest they find themselves unable to save a
carefully-crafted image layer without first closing every other image and extraneous
program, or emptying their clipboard and their command history, or taking steps to
increase the system memory that their graphics editor can use, or even all of the above.

Amongst  the  other  possible  properties  of
Layer  1,  whether  is  is  a  raster  layer  or  a
vector  layer,  will  be its  initial  colour or  its
transparency,  the  latter  being  typically
indicated  by  a  chequerboard  of  white  and
grey,  as  illustrated by  the  image  shown to
the left.  Transparency in the layer of a flag
design image is analogous to the clear areas

https://chatterbox.otru.org/physical-elements/cigarette-size/
https://chatterbox.otru.org/physical-elements/cigarette-size/
https://flagoptions.com/wp-content/uploads/Flag-Stories-14-to-23.pdf
https://flagoptions.com/wp-content/uploads/Flag-Stories-1-to-13.pdf
https://flagstories.co/
https://en.wikipedia.org/wiki/List_of_non-rectangular_flags
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of the acetate pages in the anatomy pamphlets and the book inserts mentioned earlier,
although thankfully without any analogy to the spectacular flammability  of  acetate.
There is no need for Layer 1 to have any initial colour, because it can be added later,
but if the flag designer already knows the exact primary field colour of the flag that they
will be designing, it can be specified when Layer 1 is created, and its initial label might
even be changed from 'Layer 1' to something like 'Background Field'.  As the layers of a
flag design become more numerous, in fact, giving each of them a descriptive name will
usually help to prevent confusion, as will giving the layered flag design file itself a name
that will  distinguish it  from any ordinary,  single-layer image file.   Such flag design
filenames as 'Layers for Design #1' or 'Design #1 Layer Cake' can pay big dividends, as
when one needs to find a layered image file in a list of other files, images or otherwise. 

To get a better idea of some of the advantages of layers, consider the illustration below.
The twelve layers at the left side of the illustration can all be part of a single, flag design
image file.  By purposefully arranging the layers, and then merging or flattening those
that have been made visible, all four of the single-layer flag design variants that are
shown at the right side of the illustration, and many others, can be easily obtained.   

Each of the flag design variants can of course be resized, converted to any of a number
of file formats, and then saved as a separate file. Also, each of the layers in what we
might refer to as the original 'layer cake' can be individually copied and saved for use in
other flag design image files.  For example, one might want to make other uses of the
layer that is depicted to the left below.  However, if one were to select that layer and
then  simply  'Copy'  it  to  the  system  clipboard,  one  might  be  disappointed  in  the
appearance of the layer after a 'Paste' operation, as depicted to the right below.  The

inherent or 'native' dimensions of an image that is part
of an otherwise transparent layer are not those of the
layer, but those of a rectangle bordering only the image.
If  we return to our anatomy booklet analogy,  we can
think  of  the  binding  of  the  acetate  pages  as  their  'indexing'

mechanism, the means by which they are all kept in proper visual alignment.  If we
were to pull two of the acetate pages out of the binding and re-order them, perhaps to
depict  the  skeleton layer  above the skin layer,  we could still  preserve  correct  layer
indexing by lining up the binding edges of the two pages, which would re-index them.
If on the other hand we were to use scissors to cut out a rectangle that tightly bordered
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the image of the skeleton, we would forfeit that page's indexing mechanism, as we did
for our copied graphics layer.  However, there is an easy way to preserve the prior
'indexing'  of  a  graphics  image  layer  that  includes  transparency,  when  desired,  by

temporarily adding small shapes to the layer in at least two of
the diagonal corners of its dimensional borders, as illustrated
to the left.  Thus the layer can be saved, and it can later be
pasted as a new layer atop an image of the same dimensions.
Once in place, its diagonal indexing shapes can be deleted.

There are far too many graphics layer 'tips and tricks' to fully
catalogue in this brief addendum, but one of them is so useful
that it cannot go unmentioned.  Whatever the dimensions of a
graphics layer, on its initial pasting atop another graphics layer
it will be perfectly centred.  Thus if we were to paste our non-
indexed,  'copied'  layer  from the  previous  example  as  a  new
layer, it might appear as illustrated to the top right, just as we
might desire.  If instead we were to paste our 'indexed' layer as
a new layer atop one of greater dimensions, it might appear as
illustrated to the bottom right, as we might or might not desire.
Flag designers will often want to incorporate 'arrays' of various kinds in their designs.
A circular array of stars, for example, is a feature of many flags.  Some graphics editors
will feature built-in methods for producing such arrays, and some will not.  For the
latter type of graphics editor all is not lost, if it can make use of the automatic centring
properties of pasted layers.  Suppose we are designing a flag for a nation of sixteen
regions, for example, or another flag for which 'sixteen' will be numerically symbolic:
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Raster  and vector  graphics  editors  have many common features,  and one that  flag
designers will need to have a basic grasp of is the RGB colour model, so for the benefit
of those who have not used a graphics editor before, this addendum will offer a primer.
Here and there it may also dip a toe into colour theory, but it will not take a deep swim.
The RGB colour model allows for 256 shades of red, 256 shades of green, and 256
shades of  blue,  meaning a possible combination of  256 x 256 x 256,  or 16,777,216
individual colours (zero to 16,777,215), roughly eight million more than human vision
can discriminate, so plenty.  RGB colour is also called 24-bit colour, because 16,777,215
expressed as a base-2 or binary number (ones and zeroes) is a string of 24 ones.  RGB
colour is also called 16 million colours, which is easier than saying '16,777,216'.  Each of
the 16,777,216 RGB colours from zero to 16,777,215 can also be expressed as a base-16
or hexadecimal number ranging from  #000000  to #FFFFFF (hex digits  are zero-
through-nine plus A-through-F).  The preceding hash mark signals: “This is a coded
'hex notation' of a particular RGB colour.”  In hex, '00' equals zero and 'FF' equals 255,
so when RGB colour is 'coded' using hex notation, the first two digits of the six-digit
hex number specify one of 256 shades of red (from zero to 255), the middle two digits
specify one of 256 shades of green, and the last two digits specify one of 256 shades of
blue.  Included in the RGB colour model are pure black, pure white, and 254 shades of
grey betwixt them, which taken together comprise the 256 values of 'greyscale'.  Of
course, real life actually has more than 254 shades of grey between black and white, but
you can't have everything.  In hex notation #000000 is pure black and #FFFFFF is
pure white.  When all three of the pairs of two-digit hex values are the same, but they
are neither 00 nor FF, they specify one of the 254 shades of grey that lie between black
and white.  For example,  #282828,  #7B7B7B,  #A6A6A6, and  #BEBEBE are hex
notations for four different greys.  If you fully grasp the relationships described in this
paragraph, you will probably realise that when all three red, green, and blue decimal
values are zero, they will specify pure black, when all three of their decimal values are
255, they will specify pure white, and when all three of their decimal values are the
same,  but lying somewhere between one and 254,  they will  specify  one of  the 254
shades of grey between black and white.  Greyscale is thus an 8-bit model, because in
base-2 binary, 255 is a string of eight ones, so greyscale is an 8-bit ‘black-and-white’
model, nested in the 24-bit RGB colour model.  Some graphics editors will allow one to
work not only with 24-bit colour, but with 16-bit colour, 8-bit colour, 4-bit colour, and
even 1-bit colour (only pure black and pure white).  All have advantages, but not for
flag design, so stick with 24-bit RGB colour.  To make matters more confusing, some
graphics editors use a colour model called RGBA, where the 'A' is an 'alpha' channel
that specifies how transparent or opaque an RGB colour is, whether respectively on a
scale from zero to one, or from zero to 100%, or from zero to 255, or even from 00 to
FF.  Graphics editors that do not specify an alpha channel will generally provide other
ways of varying the 'opacity' of RGB colours.  Got all that?  If not, no worries, it will all
become clear when you pick colours in a graphics editor for use in an actual flag design.

https://web.archive.org/web/20220422065319/https://colormatters.com/color-and-design/basic-color-theory
https://web.archive.org/web/20220407002509/https://www.lifewire.com/color-models-rgb-1697461
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After examining the typical colour picker applets that have been illustrated above and
on the previous page, the reader may safely assume that all such applets will have a box
where a hex notation that specifies one of the 16,777,216 RGB colours can be entered,
or where it will appear automatically, if the RGB colour has been selected by means of
other provisions in the applet.  The RGB hex notation box is always easy to locate, but
it may not be labelled, and even if it is, its label may not be 'hex notation', but rather
'hex',  'hex #',  'hex triplet',  'RGBA', 'HTML code',  'HTML notation',  or possibly even
something else.  When one manually enters RGB hex notation into such a box, usually
no leading hash mark need be included, just as 'www' need not be included in the URL
address box of an Internet browser.  One only need enter the six digits of the RGB hex
notation, and the graphics editor will understand one's intent.  For an 'RGBA'-labelled
box, an 'A' or alpha setting entry will be optional, so flag designers can safely ignore it.
'HTML'-type labels are a reflection of the fact that Web pages only know which colours
to display due to RGB hex notations within their HyperText Markup Language coding.

As far as a flag designer is concerned, only the RGB colour model matters, so any other
colour model or  colour space that a graphics editor's colour picker applet may tempt
one to muck with, such as HSL and HSV, CMYK, or CIE and LCh, will best be ignored.
As far as a graphics editor is concerned, only a colour's RGB hex notation matters, and
no matter how elaborate the human-machine-interface of a colour picker applet may
be, everything but its hex notation box will just be for the benefit of us mouse clickers.

It follows that each of the exact colours that are used in a flag design will ultimately be
defined by its RGB hex notation, which is really the most convenient way in which a
flag colour can be defined, so it likewise follows that flag designers will be wise to keep
some kind of written list of the RGB hex notations for all of the colours in their designs.

When you were a wee ankle-biter in kindergarten or
in primary school, did you occasionally have, amongst
your possessions, a small tin palette of water colours?
Whether you did or you did not, such a concise and
handy tin of colours is a fair analogy for the palette of
colours that one must select for use in a flag design.

Ultimately flag designers will need to know RGB hex notations for all of the colours in
their palettes, so we will return to that, but first we should consider how they might
best choose their palettes, which will basically boil down to one of three approaches.

First there is the approach that the author of Good Flag, Bad Flag suggests.  According
to him, a flag designer's palette should be far more limited than that of an ankle-biter's
tin, comprising only two or three colours, or perhaps four at the most, since he claims
that any more will be 'hard to distinguish', but whether the acceptable colours number
two, three, or four, he says that they should be selected from “the standard colour set”.
He uses that precise term twice in his pamphlet, yet doubling zero still  yields zero:

https://en.wikipedia.org/wiki/CIELAB_color_space
https://en.wikipedia.org/wiki/CMYK_color_model
https://en.wikipedia.org/wiki/HSL_and_HSV
https://en.wikipedia.org/wiki/Color_space


GRAPHICS FOR FLAG DESIGN --- 11 July 2024 --- Anne Onimous --- page 11

There is no such thing as 'the standard colour set' of flag design.  It seems unlikely that
the author of GFBF is referring to the 16,777,216 possible colours of a digitally-printed
flag, nor to the well over 1,300 possible ink colours that can grace a screen-printed flag,
nor even to the 75-or-more flag fabric colours that are commercially available to serve
as a starting-point for a screen-printed flag or for a sewn flag.  So what is he on about?
Perhaps we can decipher this clue: "The basic flag colours are red, blue, green, black,
yellow, and white.  They can range from dark to light.  Occasionally other colours are
also  used,  such  as  purple,  grey,  and orange...".   What  a  masterful  way  of  saying
absolutely nothing at all.  A liberal interpretation of 'they can range from dark to light'
would include each of the 256 possible shades of red, green, and blue, in which case we
would be left with sixteen million colours.  So once again, what the bloody hell could he
possibly mean by his pulled-from-an-orifice, imaginary term, 'the standard colour set'?

The only logical conclusion is that he is referring to the rather tightly-standardised
'heraldic tinctures' of armorial bearings and of coats of arms.  The idea that the colours
of flag designs should be limited to heraldic tinctures is rooted in a pre-mid-twentieth
century mindset,  when anything to  do with flags  was generally  considered to be a
subcategory  of  the  topic  of  heraldry.   If  one  considers  the  actual  hues  of  heraldic
tinctures, one will observe that except for black and white they are essentially the six
colours of Nature's spectral rainbow, meaning red, orange, yellow, green, light blue,
and dark blue (Sir Isaac Newton basically only made his tortured split of dark blue into
indigo and violet because of occult beliefs that he harboured about the number 'seven').
Given rather short shrift in the heraldic tinctures are 'non-spectral' colours that do not
occur in Nature's  rainbow, such as  brown (orange darkened with black),  pink (red
lightened with white), and magenta (which like purple combines the reds of one end of
the rainbow with blues from its other end).  Grey is another non-spectral colour that
often goes without mention, except when it is elevated by terms like 'silver' or 'cendrée'.

Limiting flag colours to the dozen-or-so that comprise traditional heraldic tinctures is a
pointless approach.  It is neither based in logic nor in necessity, and is merely another
example of the basic GFBF credo of adhering to simplicity for simplicity's sake.  To give
credit where credit is due, European heraldic bearings have sometimes been a source
for flag colours, although mostly in the mid-to-late nineteenth century, and even now
they can often provide other valuable forms of cultural symbolism that may be used
within a flag design, such as shapes, patterns, official flora and fauna, and inscriptions.
Heraldic rules of colour also include 'common sense' guidelines about adjacent colours
ideally having good contrast, or of otherwise being separated by contrasting borders.
Yet the purposes of flags differ from those of arms, and so do the ways in which their
colours should be chosen to best serve their differing purposes.  Flag design is only in
the loosest sense allied with heraldry, because it is a completely separate visual art.

A second approach to choosing flag colours is one that a graphic designer might take.
For the purposes of this addendum, 'graphic design' is also intended to mean graphic
art and commercial art, which one can argue are more or less peas from the same pod.
What students of graphic design are primarily taught about colour choices, in the two-
to-four years of formal study that may pave their way towards becoming actual graphic
designers,  graphic artists,  and commercial  artists,  as well  as what they continue to
learn about colour choices, once they have become employed under one of those titles,
is how to suit their choices to the purposes of graphic design.  Those purposes usually
being commercial, they are highly unlikely to align with those of flags.  Like heraldry,
graphic design is a completely different form of visual art.  It serves altogether different
purposes than the visual art of flag design, as will colours chosen to suit its purposes.

https://www.crwflags.com/fotw/Flags/vxt-h1.html
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Nevertheless, both the colour theory and the colour   schemes   that are taught to graphic
designers can be valuable for flag designers to have a basic grasp of as well, and it will
do them no harm to view some 'basics of graphic design' YouTube videos like this one,
this  one,  this  one,  and  this  one.   Yet  for  the  most  part  flag  designers  will  not  be
concerned with the many clever ways in which the primary, secondary, and tertiary
hues of a colour wheel can be combined to form aesthetically pleasing colour schemes.

The approach to flag colour that is championed by this addendum is the one that has
been presented on pages 44-46 of the PDF entitled “Good Flag, Bad Flag is Rubbish”,
where it is thoroughly explained.  Here the approach will only be briefly summarised:
The best colours that can be chosen for use in a flag design will usually be those that
are    culturally  symbolic   to  the  persons  whom the  flag  is  intended  to  represent  .
These  may include  the  precise  'official'  colours  of  nations,  provinces,  states,  cities,
organisations, and so-on, including any official colours that have already been used for
the flags of any or all of those entities, as well as colours that may be spiritually or
politically significant within the culture for which a flag is being designed.  The chief
virtue of  such colours is  that  their  symbolism will  be obvious,  and thus inherently
strong.  Colours that are not  culturally symbolic may still carry  emotional meaning,
but their symbolism will generally be of a weaker sort, because the meaning of a given
colour can vary widely between different cultures, and even within a given culture.

Whatever approach that flag designers may elect to take when choosing the colours in
their  palettes,  they  will  inevitably  choose  specific colours  for  their  flags  from  the
Pantone Colour Matching System (PMS), which has become the dominant standard of
colour reproduction for almost all industries worldwide, including flag manufacture.
To be clear, the Pantone people do not manufacture flag inks, nor inks of any kind.
They make their money by selling books and booklets of standardised colour swatches,
which are in turn used by various manufacturers to bring the colours of their products
into world-wide conformance.  There are supposedly about 15,000 different Pantone
colours, but perhaps only 1,347 of them are particularly relevant to flag manufacture.
These  are  the  Pantone  'coated'  colours,  designated  with  a  'C'  in  their  Pantone  ID
numbers.  Almost all officially designated colours for flags will be Pantone 'C' colours,
which appear 'brighter' than Pantone uncoated 'U' colours with the same ID number,
and which will work well for most modern flag fabrics, perhaps most notably polyester.

In any event, flag manufacturers do not use flag colours that are chosen from GFBF's
imaginary 'standard colour set'.  Instead they will formulate the colours of the inks that
they will use to match the Pantone colour values that are specified by the flag designer.
For their graphics editors, flag designers will need to 'translate' Pantone colours into

their  'close-as-possible',  RGB  hex  notation
equivalents.  The Pantone people are aware
of this need, so in addition to selling physical
colour swatches they also sell a service called
'Pantone Connect', as typified by the image
to  the  left.   This  service  amounts  to  what
could be considered the most 'official' way of
converting  a  given  Pantone  colour  into  its
equivalents  in  other  colour  systems,
including RGB hex notation.  Note that the
conversions  in  the  image  are  greyed  out.
Even for a single swatch, the Pantone people
are not keen to give anything away for free.

https://web.archive.org/web/20220508002448/https://www.pantone.com/connect
https://web.archive.org/web/20220318160846/https://www.pantone.com/color-systems/pantone-color-systems-explained
https://flagoptions.com/wp-content/uploads/Good-Flag-Bad-Flag-is-Rubbish.pdf
https://www.youtube.com/watch?v=_2LLXnUdUIc
https://www.youtube.com/watch?v=a5KYlHNKQB8
https://www.youtube.com/watch?v=MELKuexR3sQ
https://www.youtube.com/watch?v=YqQx75OPRa0
https://www.shutterstock.com/blog/complete-guide-color-in-design
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Depicted here are the 1,347 Pantone 'coated' colours that can be
formulated into inks for use in the manufacture of screen-printed
flags, or that can otherwise be colour-matched for the manufacture
of digitally-printed flags or sewn-together flags.  They have been
assembled  into  the  low-resolution  image  below  from  a  website
where each colour has been indexed with its Pantone ID number
and with a close-equivalent RGB hex notation for graphics editors.
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The Pantone people want to sell physical colour swatches, and they consider both their
swatches and their swatch numbering system to be their intellectual property, so their
website does not display the 1,347  digital colour swatches that are depicted on the
previous page.  Fortunately for flag designers this has not prevented  other websites
from depicting digital Pantone colour swatches, along with reasonably-close, RGB hex
notation equivalents.  One of the best of these websites is hex-to-rgb.com, from which
the image on the previous page was derived.  The persons behind hex-to-rgb.com may
have assembled their information from a one-time use of the Pantone Connect service,
or they may have laboriously pieced their data together by other means, as many other
websites seem to have done, although with varying degrees of success and usefulness.
If flag designers rely on any of these other websites instead of on the one that has been
noted here, they should be wary of Pantone swatch ID numbers that do not include a
'C', a 'U', or any other designator.  Sometimes the 'C' is just assumed, as it probably has
been for all of the Pantone colour swatches that have been depicted on this actual flag
manufacturer's website, which incidentally only depicts 929 colours, and which also
does  not  list  any  RGB  hex  notation  equivalents.   Assumptions  are  best  avoided
whenever possible.  One should also closely examine the swatches on such websites to
verify that their colours are completely uniform, which can be tested on some Web
browsers  by  simply  'zooming'  in.   Website  images  are  sometimes  'compressed'  to
decrease their file sizes, which can often result in colour variances and inaccuracies.

Armed with all of this information, how might a flag designer go about assembling a
symbolic  colour  palette  of  Pantone  colour  swatches,  along  with  their  Pantone  ID
numbers and their close-equivalent RGB hex notations?  As an example, consider the
colours that might be assembled for some kind of Australian flag design.  Perhaps we
could begin by doing a Web search for 'official Australian colours', the results of which
would tell us that they are green and gold, with the respective Pantone values of 348 C
and 116 C.  Some of our search results might also list RGB and/or RGB hex notation
values,  but  if  we  compare  them  with  those  that  are  given  on  the  hex-to-rgb.com
website, we will probably find minor differences.  Best to stick with a single source,
which  in  our  case  would  yield  RGB  hex  notations  of  #00843D  and #FFCD00,
respectively.  For other symbolic palette colours we might research the official colours
of some existing Australian flags.  For example, the official red and blue colours that
are in the Australian national flag (quite the handy website, that one), are respectively
185 C and 280 C, with RGB hex notation values of #E4002B and #012169.  The
white colour that is in the national flag is considered to be Pantone 'safe', with the RGB
hex notation of #FFFFFF.  Continuing our research, we might find that the official 'red
ochre' colour in  Australia's Northern Territory flag is  159 C, and that its RGB hex
notation value is  #CB6015.  The NT flag also features the colour black, as do many
other Australian flags.  Although Pantone provides a few 'shades' of near-black, none of
them are listed as being official for the NT flag, so we can safely assume that its black is
Pantone safe, just like its white, and that is has the RGB hex notation of #000000.

https://nt.gov.au/about-government/the-nt-flag/nt-flag-colours-and-designs
https://flagcolor.com/australian-flag-color-codes/
https://flagfactory.com.au/pages/colours-pms-charts
https://flagfactory.com.au/pages/colours-pms-charts
https://hex-to-rgb.com/charts/pantone-colors-chart/
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Amongst the advantages of assembling an image of colour palette, like the one that has
been shown on the previous page, is that it can be called up and used in a graphics
editor to let a flag designer figuratively dip the editor's 'brush' into its various colours.
More precisely, its various colours can be conveniently selected by the editor's colour
picker tool, which is typically represented by an eye-dropper icon.  One caveat is that
the colour palette should be saved as an uncompressed image file in the native format
of the graphics editor, or failing that as an uncompressed PNG file, and not as a JPEG.

Having given the novice flag designer a leg up on colour issues, this addendum needs
to cover a few specifics for the benefit of those designers who will be using a raster
imaging  graphics  editor,  beginning  with  a  look  at  a  couple  of  terms  that  were
previously mentioned yet left undefined, namely 'pixel density' and 'anti-aliasing'.  

All raster images are composed of pixels, which are tiny
squares of uniform colour.  Pixel density is an expression
of the number of pixels that can fit within a given unit of

measure.  For raster images, pixel density can be expressed as
either pixels-per-centimetre (PPcm) or pixels-per-inch (PPI).
The image above left  is  actually an amalgam of two images,
with the top image having a pixel density of 10 PPcm, and with
the bottom image having a pixel density of 100 PPcm.  At the
normal viewing size of this addendum, little if any difference
will be perceived in the two images.  The same image amalgam
has been reproduced at a larger scale to the right, and now the
two images display a pronounced difference in visual quality,
allowing us to realise that the image is an X-ray of a bird, in this case one of the five
species of the New Zealand kiwi.  Female kiwis lay incredibly huge eggs in proportion
to their body sizes, and the X-ray reveals this as few other images would be able to do.
Although the bottom image in the amalgam now looks sharp, if we continue to enlarge
it we will reach a point where it, too, will appear somewhat blocky, or 'pixelated', as in
the  enlarged  excerpt  from  the  bottom  image  that  has  been
shown to the right.  Along the edges of the excerpt, the pixels
are not sharply stair-stepped.  Instead they are blended with
other pixels of varying colour in what is called anti-aliasing, the
effect of which is to give the edges of raster images a visual
smoothing.   Good raster  image  editors  are  capable  of  using
anti-aliasing in a number of ways.  For example, some raster
editors  allow  image  resizing  to  be  a  'smart'  process,  with
additional anti-aliasing applied to make the image appear as
smooth as possible at its new size.  Alternatively, the pixels in
an image themselves can be resized, in which case no new anti-aliasing will be applied
(pixel resizing was the method used for all of the variously-sized images on this page).
Anti-aliasing can not only come into play when resizing images, but when creating text
and other objects, when making selections, when selecting or changing colours, and in
many other ways that will really only become clear to a user with their use of an editor.

What we are leading up to is what might be thought
of as an 'ideal' pixel density for flag designs that are
created using raster image editors.   From what we
have seen, an original or 'native' pixel density of 10
PPcm, as in the design left, will not be good enough,
but one of 100 PPcm, as in the design right, might.

https://www.savethekiwi.nz/about-kiwi/kiwi-facts/enormous-egg/
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It is an unfortunate fact that many raster image graphics programs, especially older
ones, will have a 'default' pixel density setting of 72 PPI upon their initial installation.
The reason is down to a bit of computer arcana.  In the 1980s, Apple had a fledgling
computer monitor with a display density of 72 PPI, as well as a dot-matrix printer with
a print resolution of 72 DPI.  By limiting raster images to a pixel density of 72 PPI, an
image on the monitor would always be at its native dimensions, and a print of the
image would also always be at its native dimensions.  All of this was a big selling point
that was referred to as 'WYSIWYG' (wiz'-ee-wig), or 'what you see is what you get'.
Thus 72 PPI became an early pixel density standard, and one that is sadly still with us.
A pixel density of 72 PPI is equivalent to one of just over 28 PPcm, which frankly is just
not much better than 10 PPcm for a flag design.  Again, should the default pixel density
of raster graphics editors be 100 PPcm/254 PPI?  Although opinions vary, the general
consensus is that raster images look best at their original or 'native' sizes when their
pixel densities range from 220 to 300 PPI, or about 87 to 118 PPcm.  As far as large,
high-quality digital raster images go, pixel densities far above 118 PPcm may certainly
be appropriate, but as far as raster images of flag designs go, anything above a pixel
density of about 300 PPI/118 PPcm will essentially be a waste, or at least when the
native heights of those flag designs are only ten centimetres, which as the reader may
recall was the previously-recommended height for finished flag design layers.  Also,
although modern printers can produce prints of 600 dots-per-inch (DPI) or even 1200
DPI and higher, it is generally agreed that most prints gain little or nothing by being
printed at resolutions above 300 DPI.  This does not mean that raster images should
perfectly follow suit, with pixel densities of 300 PPI, because few if any human eyes can
see a difference in the print of a 254 PPI raster image versus the print of a 300 PPI
raster image, as long as both raster images are printed in their native dimensions.
Also, for a given set of native dimensions, the file size of a raster image will increase
with its pixel density, so 100 PPcm has a bit of an advantage over 118 PPcm there, too,
and most certainly over even higher densities.  Also, if a flag design has a pixel density
of 100 PPcm and a height of 10 cm, it will have a height of 1000 pixels, a good and
easily-remembered number that is exactly divisible in many ways.  If the 10 cm design
height  is  only  intended  for  finished  designs  and/or  contest  submission,  and  the
designer prefers, say, a 30 cm height for unfinished designs, a 100 PPcm pixel density
will equate to a height of 3000 pixels, which will be exactly divisible in even more ways.
So yes, 100 PPcm/254 PPI is a good default pixel density for raster image flag designs.

To  wrap  up  our  discussion  regarding
raster  imaging,  we  should  say  a  few
more words about bit  depth, which as
previously  noted  will  also  be  relevant
for vector imaging.  Consider the raster
image to the left, which depicts a Kodak
multiracial  'Shirley  card'  of  the  1990s.
The image has been embedded on this
page in its actual dimensions of 10 cm
by 10 cm,  with  a  pixel  density  of  100
PPcm.  It follows that the dimensions of
the image are 1000 by 1000 pixels (one
million total), along the lines that were
discussed  in  the  previous  paragraph.
The image has been rendered in 24-bit
RGB colour, as you might expect.  In all
respects it is sharp, clear and colourful.

https://web.archive.org/web/20220324055047/https://www.npr.org/2014/11/13/363517842/for-decades-kodak-s-shirley-cards-set-photography-s-skin-tone-standard
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In each of the images in the strip of images further below, a one-square-centimetre
section of the Shirley card raster image on the previous page has been extracted and
then enlarged by a factor of exactly 4.75. The enlargement has been effected using a
graphics editor that allows pixel resizing, so that each of the images is still 100 pixels
square, just as when they were originally only one cm square.  Thus each image has a
total of 10,000 pixels.  The leftmost raster image still seems reasonably sharp at its
4.75 enlargement.  It retains the 24-bit colour depth of the original image, although it
actually only displays 697 pixel colours out of a possible 16,777,216.  The second raster
image has been given an 8-bit colour depth, and although it displays 255 colours out of
a possible 256, it has slightly sacrificed some of the sharpness of the first image.  The
third raster image has been given a 4-bit colour depth, and although it uses all sixteen
of its possible pixel colours, it has very poor quality.  The fourth raster image, included
just  to  complete  the  discussion,  has  been given  a  1-bit  colour  depth.   It  has  been
processed so that its pure black or white pixels can be perceived as shades of grey by
the human eye, much like half-tone images in old newspapers.  It represents a true
'black-and-white' image, although we also apply that term colloquially to monochrome
'B&W' photos and films, and sometimes even less accurately to greyscale raster images.

As noted earlier, the larger the pixel density of a raster image, the larger its file size.
The file size of a raster image will also be larger with increases in bit depth.  This might
lead one to think that raster flag designs with 8-bit colour may be preferable to those
using 24-bit RGB colour.  After all, the second image above is only slight degraded, so
under certain circumstances there might be something to be said for this approach.
However, if we remember that there are 1,347 possible RGB Pantone C flag colours,
reducing them to the nearest 256 may no longer seem so attractive.  The file sizes of
24-bit raster images are not all that cumbersome anyway, as long as their dimensions
are kept reasonable, and as long as their pixel densities remain at 100 PPcm.  So those
are the recommendations of this addendum for designers who chose raster imaging.

Up to this point, the author of this document has made a deliberate effort to present
objective information for flag designers to consider when choosing a graphics editor.
The remainder of this document will promote the author's four subjective preferences,
which are Windows platform products dating from 2001 through 2004.  If you are an
Apple user, you will have to run them in a Windows emulator.  If you are a Linux user,
you will have to run them in something like the Wine utility.    All four can be installed
and used for free.  The first three are mainly raster imaging editors, although they can
also produce vector layers, objects, and full flag designs.  The fourth is for SVGs only.

In 1991, the computer scientist Robert Voit founded Jasc Software, and he created the
first version of Paint Shop Pro, which he sold under the label of his new company.  As
the years went by, and as new versions were released, PSP gained a steady and loyal
following as  a powerful  and affordable option to Adobe Photoshop,  perhaps to the
point of becoming a genuine thorn in Adobe's side, judging from the fact that even to

https://web.archive.org/web/20201112020234/https://www.vice.com/en/article/mgxa53/how-an-airline-pilot-took-on-adobe-photoshopand-nearly-won


GRAPHICS FOR FLAG DESIGN --- 11 July 2024 --- Anne Onimous --- page 18

this day, Photoshop will not open graphics files in any PSP format.  But ignoring PSP
did not make it go away, and by late-2001 it was such a successful and mature product
that it was released in a 'Tenth Anniversary Edition' as Jasc Paint Shop Pro version
7.04, a powerful and user-friendly product with nearly all of the features that any flag
designer could want.  By 2004, PSP had gone through versions 8.10 and 9.01, at which
point the Corel Corporation bought Jasc Software, and eventually managed to muck up
the PSP interface, or so claim many of the loyal users of pre-Corel versions.  Corel still
markets PSP, but whether their versions improve on the old Jasc versions is debatable.

One drawback of PSP 7.04 is that its built-in 'help' files are in an outdated format that
cannot function in Windows 10 and later, nor even in Windows Vista or Windows 7
through 8.1 without the installation of a special Microsoft interpreter program.  This is
not a severe handicap, as will be explained later.  The built-in help files in PSP versions
8.10 and 9.01  do function for all versions of Windows, and those versions of course
have certain features that are not present in PSP 7.04.  All three versions have pros and
cons,  and  all  three  can  be  installed  simultaneously  on  Windows  systems  without
interfering with each other, so all three will be discussed as this document continues. 

Like prior versions of the Jasc PSP software, versions 7, 8, and 9 were sold on CDs that
each came with a unique, alphanumeric serial 'installation key'.  All three versions can
still  occasionally  be found for purchase on eBay and elsewhere,  sometimes even in
unopened packaging, ensuring that their enclosed CDs will include a valid installation
key.  When any of the three versions are installed using the regular installation 'set-up'
utility that is on the CD, and which may run automatically when the CD is inserted into
an optical drive, they will only function on a trial basis for a limited time without a key.

Unlike prior versions of the PSP software, the CDs for versions 7, 8, and 9 all included
a method of permanent installation that actually did not require an installation key.
This may have been an oversight, but one suspects that it was actually intentional on
the part of Jasc, which for its entire existence was never an overly mercenary software
company, and which always sold a good product for a reasonable price.  It is fairly
certain that the acronym 'Jasc' originally stood for 'Just Another Software Company',
which may give you an idea of the attitude that Robert Voit had towards more greedy
software providers.  It is also possible that even back in 2001, Corel had been making
purchase overtures, and with the prospect of selling Jasc, perhaps Voit wanted to leave
an  installation  'back  door'  for  his  products,  which  he  anticipated  would  either  be
discontinued or gutted beyond recognition after their sale, not an unusual occurrence.
And so, versions 7, 8, and 9 are presented here for your consideration, beginning with:

JASC PAINT SHOP PRO VERSION 7.04 (Tenth Anniversary Edition)

(1) From a Windows system, go to https://archive.org/details/jasc-paint-shop-pro-704
(2) Download the 'ISO IMAGE' file (PSP704A_AE.iso) to a folder on your system.
(3) When the download is complete, navigate to the folder where you downloaded the
ISO file.  Right-click the file and select 'Open with > Windows Explorer'.  This should
place a virtual CD/DVD drive on your system, with a drive letter immediately above
those of  whatever  physical  drives  your  system may include.   The virtual  drive  will
remain on your system until the virtual CD is ejected or until your system is restarted.
The virtual  CD will  probably open to its  root  directory automatically,  but if  it  also
attempts to auto-install,  do not allow it to do so.  Instead just open the CD to its
root directory, where you can read its two 'Readme' files if you like, but do not click
autorun.exe.  (If this step does not work as described, you have the option of burning

https://archive.org/details/jasc-paint-shop-pro-704
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the ISO file to a physical CD or to a bootable thumb-drive, and to carry on from there.)
(4) From the root directory of the virtual CD, physical CD, or bootable thumb-drive,
open the 'PSP' directory.  Do not click setup.exe.  Instead click the file that is named
'Paint Shop Pro 7 Anniversary Edition.msi'.  An installation window should appear:

(5) Click 'Next' to see the licence agreement.  Select the 'I accept' bullet and click 'Next':
(6) In  the  'Customer  Information'  window  that  opens,  enter  'User  Name'  and/or
'Organisation' in the appropriate spaces, or leave them blank, select either the bullet
that will allow the software to be used by 'Anyone who uses this computer (all users)' or
'Only for me ( _______ )', and click 'Next'.
(7) In the 'Setup Type' window that opens, select the 'Custom' bullet and click 'Next'.
In the 'Custom Setup' window that opens, select the options that are indicated in the
two images below (eliminating outdated and superfluous features) and click 'Next':
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(9) In the 'Ready to Install the Program' window that appears, click 'Install', …

… allow the installation to run to completion, …

… select the bullets that you prefer in the 'User Options' window that appears, …

… and click 'Next' to see the 'InstallShield Wizard Completed' window.  Click 'Finish'.
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At some point during or after installing PSP 7.04, you may see a window asking you to
register your software.  Click 'Skip', 'Never remind me again', or the like.  Jasc Software
no longer exists, and neither do any of their old registration servers.  You also cannot
register your software with Corel, since they too offer no way to register Jasc products.

When you run PSP 7.04 for the first time, you will be presented with a window in
which you can choose 'File Format Associations'.  Any choices that you make can be
changed at a later time, so you may want to choose 'Select All' and click 'OK', so as to
make  PSP  7.04  the  default  software  that  will  open  all  of  the  image  types  listed
(although Windows will probably fight you on some or all of your choices).  You will
then be presented with a 'Tip of  the Day'  window that will  allow you to see a 'tip'
whenever you start the program.  If you wish, clear the tick box and click 'Close'.  The
default appearance of the PSP 7.04 window on its first run will probably look like this:

Close the program and run it again.  At start-up it will now probably appear as in the
illustration at the top of the following page. 
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Click 'OK' on the splash screen to close it, and then close 'Tool Options – Arrow', 'Layer
Palette',  and  'Overview  Window'.   Along  the  left  edge  of  the  window  is  the  'Tool
Palette'.  You may like it where it is, but for now click and drag it by the stripe at its top
end and drop it to the right of the 'Standard Toolbar', as illustrated below.  You may
need to resize the PSP 7.04 window to accommodate the full length of the Tool Palette.
Right-click the Standard Toolbar and select 'Customise' to open the 'Toolbars' window
that is shown at the centre of the image below.  Clear all of the tick boxes at its bottom.
You can experiment with enabling and disabling the various toolbars.  Note that the
'Customise' button will be enabled for some of them, when they are selected.  We will
come back to  that.   When you have finished experimenting,  ensure  that  'Standard
Toolbar', 'Tool Palette', 'Colour Palette', and 'Status Bar' are ticked, and click 'Close'.
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Click 'File > Preferences > General Program Preferences' to open the 'Paint Shop Pro
Preferences' window.  Suggested settings for its eight tabs are illustrated below:
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In the 'Colour Palette' at the right of the PSP 7.04 window, click the Styles
right arrow buttons and pick the 'Solid' brush icons.  Note that you can also
choose gradient colours or patterns.  Tick the 'Lock' box to make the Styles
choices automatically work in concert for all tools that have optional border
and interior fill treatments, such as text and shapes, which can either have
solid colours or patterns throughout, or differing outline and fill  colours
and/or patterns.  When the Styles buttons are solid colours, the top button
is the 'foreground' colour, and the bottom button is the 'background' colour.
Clicking the dual arrow to their left will swap their positions and functions,
as will the double arrow at the top of the Colour Palette.  Click on one or
both of the Styles buttons to open the PSP 7.04 colour picker.  Experiment
to gain familiarity with the ways in which it can be used.  Also investigate
the 'Textures' buttons.  When one or both of them are enabled, a foreground
and/or background texture will  be applied to the solid colours,  gradient
colours,  or  patterns  of  your  chosen Styles.   Move  your  mouse  over  the
rainbow-like area to see the RGB decimal values for its various hues.  Note
that clicking within the area only changes the foreground Style colour.  

Often it can be useful to have a maximum horizontal working area in the PSP 7.04
window, including the fair amount of horizontal space that the Colour Palette occupies.
At the top of the PSP 7.04 window you will see the six buttons below:

Respectively from left to right, these are 'visibility toggles' for the Tool Palette (which
you already moved out of the way in an earlier step), the Tool Options Window (which
we will take a closer look at later), the Colour Palette (which we definitely may want to
occasionally  hide),  the  'Histogram  Window  (which  is  not  of  much  use  to  a  flag
designer),  the  'Layer  Palette'  (which  can  be  useful,  but  which  is  also  somewhat
unnecessary in PSP 7.04), and the Overview Window (which is also a little redundant,
since it basically just display a miniature view of the PSP window).  The toggle buttons
have a 3D look because we disabled 'Display flat style toolbars' in an earlier procedure.
You can experiment by toggling all of them, although they will not show much for now.

Close and restart the PSP 7.04 graphics editor.  In the menu at the top of the PSP 7.04
window, click ‘File > New’ to open the ‘New Image’ window shown to the left below.
Make all of its settings match those that are shown, and click ‘OK’ to see ‘Image1’ in the
PSP 7.04 window.  If you are using a ‘wheel’ mouse, hover your mouse cursor over
Image1 and roll the wheel to zoom in or out.  In the menu at the top of the PSP 7.04
window, click ‘View > Rulers’ to make Image1 appear as illustrated to the right below.
Note that because the image has a pixel depth of 100 PPcm, the vertical and horizontal

graduations of the rulers
are  in  both  millimetres
and pixels, which can be
convenient  for  dividing
a  background  field.   In
the  menu at  the  top  of
the  PSP  7.04  window,
click ‘Layers > Merge >
Merge  All  (Flatten)’.
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Image1 should now be solid white.  In the menu at the top of the PSP 7.04 window,
click ‘Colour > Negative Image’.  Image1 should now be solid black.  Right click the
Image1 title bar and select ‘Copy’.  Move your mouse cursor to an open area in the PSP
7.04 window, right-click again, and select ‘Paste’.  You should now have a solid black
Image2.  Ensure that the foreground Style in the Colour Palette is a solid colour.  In the
Tool Palette at the top of the PSP 7.04 window, find and select the ‘Flood Fill’ tool,
which appears as a ‘tipping paint can’  icon.  Click the visibility  toggle  for the Tool
Options Window, which should appear as illustrated to the left below.  This window

will change to indicate options for whatever tool has been selected
in the Tool  Palette.   Note that  you can move the  Tool  Options
window outside of the PSP 7.04 window.  This will also be true for
many other palettes and option windows, such that a flag designer
can have many options available on a second monitor.  Use the
toggle to hide the Tool Options window.  Note that Flood Fill is
still the selected tool.  Hover your mouse cursor over Image2 and
left-click.  Image2 should now have the Styles foreground colour.
Ensure  that  the  Styles  background has  a  different  solid  colour.
Hover your mouse cursor over Image2 and  right-click.  Image2

should now have the Styles background colour.  In the menu at the top of the PSP 7.04
window, click ‘Edit  > Undo Flood Fill’.   Image2 should once again have the Styles
foreground colour.  In the menu at the top of the PSP 7.04 window, click ‘Selections >
Select All’.  Note the animated dashed line that indicates the selected area in Image2.
In the menu at the top of the PSP 7.04 window, click ‘Edit > Clear’, or alternatively
push the ‘Delete’  key on your keyboard.  Image2 should once again have the Styles
background colour.  In the menu at the top of the PSP 7.04 window, click ‘Selections>
Select None’, and note that the animated dashed line has disappeared.    Right-click the
Image2 title bar and select ‘Copy’.  Right-click the Image1 title bar and select ‘Paste As
New Layer’.  Note that the selected tool is no longer Flood Fill, but the ‘Mover’ tool.
Reselect the Flood Fill tool.  Hover your mouse over Image2 and left-click.  Image2
should once again have the Styles foreground colour.  Right-click the Image2 title bar
and select ‘Copy’.  Right-click the Image1 title bar and select ‘Paste As New Layer’.  In
the menu at the top of the PSP 7.04 window, click ‘Layers’.   If  you like, select and
‘Arrange’ each layer, examine and change its ‘Properties’, add additional raster and/or
vector layers, and experiment with other options in the Layers menu.  You can also
toggle the Layers Palette into view.  Some flag designers may prefer to use the Layers
Palette, but in PSP 7.04, the Layers file menu provides almost as much control.

If you like, experiment further with menu items, tools, and tool options.  The more you
suss out what everything is for, the easier it will be for you to apply PSP 7.04 to the
purposes of flag design.  When you have come to whatever stopping point feels good to
you, close all open images (no need to save them, but no worries if you have done so).
At the top of the PSP 7.04 window, click ‘Help > Product Tour’.  Assuming that the
‘tour’  will  run properly on your system, follow its  easy instructions and click when
needed during the largely automated, fifteen-minute-or-so presentation.  Most of what
you will learn may not be applicable to flag design, but some will, and you should gain
a better understanding of the many other things that the PSP 7.04 editor is capable of.
When you have completed the tour you may want to return to the Help menu and click
‘Help > Tutorials’ to open an informative PDF document that offers ten tutorials that
you can complete at your leisure, further bolstering your familiarity with PSP 7.04.
Note that the Help menu items ‘Help > Context Help’ and ‘Help > Help Topics’ cannot
function in Windows versions above 8.1, as was previously discussed.  As consolation,
however,  visit  https://www.corel.com/6763/psp_downloads/pub/PSP705guide.exe,

https://www.corel.com/6763/psp_downloads/pub/PSP705guide.exe
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which will allow you to download the file ‘PSP705guide.exe’ from
an old Jasc FTP server that Corel still maintains.  When run, the
executable file will place a PDF copy of the official Jasc, 146-page
“Paint Shop Pro 7 Getting Started Guide” in the directory where
you installed PSP 7.04.  You can then navigate to that directory,
which is typically ‘C: > Program Files (x86) > Jasc Software Inc >
Paint Shop Pro 7’, and make a shortcut to the PDF file, which you
may want to rename ‘PSP 7 Getting Started Guide’.  The PDF does
not have the pretty cover of the printed version of the guide, but
otherwise it is identical, and as a PDF it has the advantage of being
searchable.  If you are nervous about downloading and running an executable file, you
can alternatively download the PDF from here or from here.  Flag designers should pay
particular  attention to Chapter  3,  Getting to Know Paint  Shop Pro,  to  Chapter  11,
Using  Adjustment  Layers,  to  Chapter  12,  Using  Vector  Objects  and  Text,  and  to
Appendix A,  Paint Shop Pro Shortcuts and Hotkeys.  You may also want to visit the
Internet Archive ‘Books to Borrow’ feature, where you can freely read millions of books
after you  sign up for a free account.  Books to Borrow offers some third-party books
about PSP 7, including  this one,  this one, and  this one, but not yet the official Jasc,
500-page “Paint Shop Pro 7 Reference Guide”, a PDF version of which does not exist.

No discussion of PSP 7.04 would be complete without touching on its integrated ‘image
browser’  feature.   Unlike  many  graphics  editors  that  require  the  use  of  external
windows for common operations such as opening and saving files, Jasc Paint Shop Pro
allows all necessary file operations to take place from within its own window.  At the
top of  the PSP 7.04 window, click  ‘File  > Browse’  to  open the PSP image browser
window, as illustrated below.  The browser has a standard ‘tree’ along its left side area,
from which any folder may be chosen.  Within its right side area, the images in the
selected folder will be displayed as thumbnails.  Images can be opened with double-
clicks or by dragging their thumbnails into the PSP 7.04 window.  Right-clicks on the
thumbnails allow file operations such as ‘Copy to’, ‘Delete’, ‘Move To’, and ‘Rename’.
Right-clicking the grey area in the browser window allows the thumbnails to be sorted
and to be searched for particular images.  By making a folder like the one shown in the
browser’s tree, flag designers can easily keep track of all of their flag-related images.

https://archive.org/details/paintshoppro7for00davi
https://archive.org/details/completeidiotsgu00natg
https://archive.org/details/samsteachyoursel00clar
https://archive.org/account/signup
https://archive.org/details/inlibrary
https://flagalternatives.com/wp-content/uploads/Jasc-Paint-Shop-Pro-7-Getting-Started-Guide.pdf
https://flagoptions.com/wp-content/uploads/Jasc-Paint-Shop-Pro-7-Getting-Started-Guide.pdf
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Although the default arrangement of the PSP 7.04 user interface is reasonably good
just as it is, it can always be customised in ways that may better suit the needs of a flag
designer.  For example, a flag designer is apt to make extensive use of a mouse for such
operations  as  cut,  copy,  and  paste,  so  the  removal  of  dedicated  buttons  for  those
functions may help to streamline the interface.   Moreover,  if  the Tool  Palette is  to
remain where we previously relocated it, at the top of the PSP 7.04 window to the right
of the Standard Toolbar, there will be no need for it to have a visibility toggle button.
Of course these are only some possibilities, and any actual customisations should serve
the personal preferences and habits of the user.  At the top of the PSP 7.04 window,
click  ‘View  >  Toolbars’.   In  the  Toolbars  window  that  opens,  highlight  ‘Standard
Toolbar’ and click the ‘Customise’ button to open the ‘Customise Toolbar’ window that
is shown in the image below.  Note that the window allows ‘Available toolbar buttons’
to be added, and that it allows ‘Current toolbar buttons’ to be removed or rearranged.
If you scroll through all of the available toolbar buttons, you will find one of them for
practically any function in the entire file menu.  Along the top of the window that is
depicted below, a suggested customisation of the Standard Toolbar has been effected.
Its  buttons  are:  New,  Open,  Browse,  Save,  Print,  Image  Information,  Undo,  Redo,
Toggle Tool Options Window, and Toggle Colour Palette, along with a few Separators.
The Tool Palette in PSP 7.04 cannot be customised, nor does it particularly need to be.  

The PSP 7.04 window has been shown ‘compressed’ in prior illustrations, so perhaps a
final look should depict it filled with a flag design on the screen of a large monitor:
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The native file format of PSP 7.04 is ‘.psp’.  PSP 7.04 cannot open PDF or SVG image
files, nor can it save vector image PSP files as ‘.pdf’ files or as ‘.svg’ files.  However, PSP
7.04 can save vector image PSP files as Photoshop PSD (‘.psd’) files, which can then be
converted to PDF or SVG files using third-party converters such as this one or this one.
The  native  file  format  of  PSP  8.10/PSP  9.01  included  new  features,  so  it  became
‘.PspImage’.  V8/V9 can open all PSP files, but V7 cannot open all PSPIMAGE files.
V8/V9 can also open PDF and SVG files.  Like V7 they cannot save files to PDF or SVG,
but also like V7 they can save files to PSD format, for later conversion to PDF or SVG.

JASC PAINT SHOP PRO VERSION 8.10

(1) Go to https://archive.org/details/jasc-paint-shop-pro-8
(2) Download the 'ISO IMAGE' file (Jasc Paint Shop Pro 8.iso) to one of your folders.
(3) When the download is complete, navigate to the folder where you downloaded the
ISO file.  Right-click the file and select 'Open with > Windows Explorer'.  This should
place a virtual CD/DVD drive on your system, with a drive letter immediately above
those of  whatever  physical  drives  your  system may include.   The virtual  drive  will
remain on your system until the virtual CD is ejected or until your system is restarted.
The virtual  CD will  probably open to its  root  directory automatically,  but if  it  also
attempts to auto-install,  do not allow it to do so.  Instead just open the CD to its
root  directory,  but  do  not  click  autorun.exe.   (If  this  step  does  not  work  as
described, you can still burn the ISO to a physical CD or to a bootable thumb-drive.)
(4) From the root directory of the virtual CD, physical CD, or bootable thumb-drive,
open the 'PSP' directory.  Do not click setup.exe.  Instead click the file that is named
'Jasc Paint Shop Pro 8.msi'.  An installation window should appear.
(5) Click 'Next' to see the licence agreement.  Select the 'I accept' bullet and click 'Next'.
(6) In the 'Customer Information' window that opens, fill in the spaces or leave them
blank, select an appropriate bullet for ‘Install this application for’, and click 'Next'.
(7) In the 'Custom Setup' window, select options as indicated below.  (Jasc Animation
Shop 3 is another good program, but its final version is not the one that is offered with
PSP 8.10.  You can install its final version when and if you choose to install PSP 9.01.)

Click  ‘Next’  to  open the  ‘Ready to  Install  the  Program’  window,  and click  ‘Install’.
When the installation completes, make selections in the ‘User Options’ window that
appears, and click ‘Next’.  In the software registration window that appears, click ‘Skip’.
In the ‘InstallShield Wizard Completed’ window that appears, click ‘Finish’.  When you
run PSP 8.10 for the first time, a registration window may again appear.  Click ‘Skip’.
You will probably also be presented with a ‘File Format Associations’ window, but for
the  time  being  you  should  either  click  ‘Remove  All’  or  simply  close  the  window,
especially if you have previously associated PSP 7.04 with all of the graphics files listed.

https://archive.org/details/jasc-paint-shop-pro-8
https://www.freeconvert.com/psd-to-svg
https://www.freeconvert.com/psd-to-pdf
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Amongst the differences in the default PSP 8.10 user interface from that of PSP 7.04:

 The Colour Palette has been renamed the ‘Materials Palette’, and because of its new
features it has become yet a wider horizontal intrusion into the design area window.
 Docked by default beneath the Materials Palette are the ‘Overview Palette’ and the

‘Layers Palette’.  The Standard Toolbar has no default toggles to hide these palettes.
 In the Tools Toolbar at the left side of the PSP 8.10 window, many tools have now

been ‘nested’ by default, meaning that access to some will require an extra mouse click.
 Horizontally docked beneath the Standard Toolbar is the new Tool Options Palette,

which vertically intrudes into the full width of the top of the design area window.

 As illustrated in the image below, layers are no longer listed at the bottom of the
Layers file menu, so they can only be manipulated by using the Layers Palette.
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 There is no option to give tool icons a ‘3D button’ look.  Instead all icons have a flat
appearance, and a pastel blue highlight is used to indicate any currently-selected icon.
 Except for any image that may appear in the design area, as well as the Status Bar

that appears at the bottom of the design area,  each and  every menu, tool bar, and
palette has been given a mouse cursor ‘grasping’ area that will allow it to be undocked,
re-docked or docked elsewhere, or simply moved to become a free-floating element,
either inside the design area or entirely outside of it, including on a second monitor.

When faced with  all  of  the  radical  changes to  the
PSP user interface that began with Version 8, some
of the most obvious of which have been pointed out
both above and on the previous page, many users of
Version  7  were  initially  intimidated,  so  perhaps
understandably  a  number of  them were critical  of
the changes, even to the point of opining to this day
that Version 7 was the ‘best’  version of Jasc Paint
Shop Pro that was ever developed.  Yet the default
appearance of  PSP 8.10,  on its  initial  installation,
shows only a part of its full features.  To see all of
them, as shown right, one can use the file menu item

‘File  >  Preferences  >
Reset  Preferences’,  and
make  selections  in  the
‘Reset  the  Application’
window,  as  shown  left.
This  is  a  quick  way  to
return  all  externally-
moved menus, toolbars,

and palettes, as shown in the image at the top of this
page, back to the PSP window.  Obviously PSP 8.10
was an even more powerful alternative to Photoshop
than was PSP 7.04, so it left some users yearning for
simpler times.  Yet PSP 8.10 (and PSP 9.01) can be
fully customised in ways to please any flag designer.
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Before  customising  PSP  8.10,
however, users should familiarise
themselves  with  the  many  tools
that  Jasc  included  with  the
product  to  help  its  users  to
master it.  Open the ‘Help’ menu,
as  shown  left,  and  click  ‘Help
Topics’  to  open  the  Windows-
style  help  window  shown  right.

Clicking ‘Context Help’ will change the mouse cursor into one that includes a small
question mark.  By clicking this special cursor on a feature, whether a menu, toolbar,
palette, or practically anything else, the help window will automatically open to display
information that is contextually relevant.  The special cursor will then revert to normal.

Clicking  ‘Learning  Centre’  in  the  Help  menu  will  open  the
Learning  Centre  window,  which  is  actually  a  palette  that  can
either be docked at the right edge of the design area, along with
the Materials Palette and others, or left as a free-floating window,
as shown to the left.  The Learning Centre provides step-by-step
tutorial instructions for all of the graphics operations that it lists.

Like PSP 7.04, PSP 8.10 includes an animated ‘Product Tour’ in
its  Help menu, but if  clicked it  will  probably not run, and will
instead return an error message.  Unlike the Product Tour in PSP
7.04,  which  runs  by  using  a  self-contained  version  of  the
Macromedia Flash Player, the Product Tour for PSP 8.10 was built
using Adobe Flash, an outdated video animation format that was
always  so  riddled  with  security  flaws  that  many  systems  now
simply refuse to run it under any circumstances.  However, there
is a fairly good workaround.  Go to https://ruffle.rs/#downloads
and download a version of the ‘Ruffle’ Flash Player emulator that
will  be  appropriate  for  your  system.

Unzip the downloaded files to a folder.  You should give
the folder a descriptive name, such as ‘Ruffle Flash Player
Emulator’,  and place it  in a permanent location on your
system, perhaps in the ‘Program Files (x86)’ directory.  In
your  Windows  settings  for  ‘Apps  >  Default  apps’,  as
illustrated to the right, enter ‘.swf’ in the ‘Set a default for a
file type’ space.  To ‘Choose a default’ program to open .swf
files, navigate using ‘More apps’ to the folder where you
have located Ruffle, select the ruffle.exe file, and click ‘OK’.

You will  still  not  be  able  to  run the  Product  Tour  from the  Help  menu.   Instead,
navigate  to  the  ‘Learning  Centre’  sub-folder  of
wherever you installed PSP 8.10.  Typically this will
be ‘C: > Program Files (x86) > Jasc Software Inc >
Paint Shop Pro 8 > Learning Centre’.  In the Learning
Centre folder, note that there are 46 SWF video files,
each with a descriptive name.  Two of the files, named
‘welcome.swf’  and  ‘jasc_com.swf’,  are  superfluous.
The file named ‘prod_tour.swf’ will launch a window
as shown to the left, from which the 43 remaining and

https://ruffle.rs/#downloads
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actually  informative videos can be played,  but
only in a fixed sequence that cannot be altered.
Not all of the videos deal with features that will
be  especially  relevant  for  flag  designers,  but
viewing the entire  sequence of  short  videos at
least once is nevertheless recommended for new
users  of  the  software.   Since  each  individual
SWF video file can be played alone at any time,
users  may  want  to  make  a  shortcut  to  the
‘Learning Centre’ folder, so that they can easily
return and review the video files that are most
instructive for them.  An index of the individual
Product  Tour  videos  and  their  corresponding
SWF files has been depicted to the left.

Incidentally, unlike Jasc PSP 7.04 and PSP 8.10,
Jasc Paint Shop Pro 9.01 includes no animated
videos Product Tour.  However, since many of
the  features  of  Paint  Shop  Pro  remained  the
same through various revisions, the PSP 7 and 8
Product Tours will also be relevant for PSP 9.01.

Whilst  you  were  exploring  the  ‘Learning Centre’  folder,  you
may have noticed its  sub-folder  labelled ‘PDF Files’.   If  you
open that folder you will  find the  “PSP 8 User Guide” PDF.
You  should  make  a  shortcut  to  this  PDF,  because  it  is  the
complete, 434-page, official Jasc user manual for PSP 8, and it
is identical to the printed version that was included with many
of the commercially-sold packages of the PSP 8 software.  As a
PDF it  is  completely searchable,  which of  course gives  it  an
important advantage over the printed version.  This brilliant
‘hidden feature’ of PSP 8.10 cannot be found in PSP 7.04, for
which only printed versions of a user guide were produced, and
PSP 9.01 likewise includes no user guide with its installation.

Also curiously obscure is another useful PDF that
one  can  only  find  by  searching  through the  old
Jasc FTP servers.  The extremely well-illustrated
“Jasc Paint Shop Pro 8 Quick Reference Guide” is
actually  a  consolidation  of  thirteen  informative
one-page  PDFs,  each  of  which  can  be  rapidly
accessed  from  the  PDF’s  hyperlinked,  ‘table  of
contents’ cover page, as shown to the left.  You can
view and download the PDF from this Corel site,
or alternatively from here or from here.

Perhaps because its interface was such a departure
from that of PSP 7, PSP 8 unquestionably has the
most ‘help’ resources of any PSP version that Jasc
ever made, as evidenced by the fact that a full two
pages of  this  document were required to simply
catalogue all the ways that one can learn to use it.

https://flagalternatives.com/wp-content/uploads/Jasc-Paint-Shop-Pro-8-Quick-Reference.pdf
https://flagoptions.com/wp-content/uploads/Jasc-Paint-Shop-Pro-8-Quick-Reference.pdf
https://www.corel.com/6763/psp_downloads/pub/psp8gid.pdf
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To customise PSP 8.10 for a flag designer, we can begin by clicking 'File > Preferences
> General Program Preferences' to open the 'Paint Shop Pro 8 Preferences' window.
Suggested settings for its nine tabs are presented below and on the following page.
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Prior to further customisations it
may  be  helpful  to  simplify  the
default appearance of the PSP 8
window, by setting the file menu
items  ‘View  >  Toolbars’  and
‘View > Palettes’ as respectively
illustrated left and right (so that
only the ‘Standard’, ‘Status’, and

‘Tools’ toolbars will show for now, and so that none of the palettes will show for now).
We can now drag and drop the Tools Toolbar to the right of the Standard Toolbar,
leaving the top of the PSP 8.10 window looking as it does in the illustration below.

If we now click ‘View > Customise’, the PSP 8.10 window will appear as shown below,
with the ‘Customise’ window ‘unlocking’ everything     visible   for possible customisation.
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Take a few moments to explore the incredible array of customisation ‘Categories’ and
‘Commands’.   As opposed to the rather limited customisation features of PSP 7.04,
those of PSP 8.10 (and those of PSP 9.01) are practically limitless,  and they are as easy
to effect as a drag-and-drop mouse operation.  To add something to the file menu, to
the  Standard  Toolbar,  or  to  the  Tools  Toolbar,  one  need  only  drag  and  drop  a
Command from the Customise window, and to remove something from the file menu,
from the Standard Toolbar, or from the Tools Toolbar, one need only perform that
operation in reverse,  by  dragging and dropping an item  to the  Customise  window.
There is no risk of ‘damaging’ the PSP 8.10 user interface, because no customisation
will be irreversible.  To get some practice, click ‘Help’, which contains the three useless
items ‘Product Tour’, ‘Register Product Online’, and ‘Jasc Software Online’.  Drag and
drop each of these items, in turn, to the Customise window.  In the Categories section
of the Customise window, select ‘Help’, and from the related Command section of the

Customise window, drag and drop ‘Context Help’ up and to the
right of ‘Help’, as illustrated to the left.  Now you can access the
Context Help feature with a single click.  Close the Customise

window and click ‘File > New’ (or the ‘New’ icon in the Standard Toolbar) to open the
‘New  Image’  window.   Change  its  settings  to  match  those
shown  in  the  image  to  the  left,  and  click  ‘OK’.   Note  that
because an image is now open, the file menu has changed to
include  additional  relevant  menu  items,  and  that  ‘Context
Help’  no  longer  appears  to  the  right  of  ‘Help’.   Open  the
Customise window again by clicking ‘View > Customise’, select
‘Help’ in the Command section of the Customise window, and
once again drag and drop ‘Context Help’ from the Commands
section of the Customise window to the right of ‘Help’.  Now
you  can  always  access  Context  Help  with  a  single  click,  no
matter what is shown in the file menu, as illustrated below:

 

By leaving both the New Image and the Customise windows open, we can easily make
many more changes to better suit the PSP 8.10 interface to the needs of flag designers.
From the Standard Toolbar, drag and drop the icons for ‘Twain Acquire’, ‘Cut’, and
‘Copy’ to the Customise window (scanning operations will be rare for flag design, and
cut, copy, and paste operations are usually easier to perform by using left and right

mouse clicks on an image, without ever involving the file
menu).  Now the Standard Toolbar should appear as it does
in the image to the left.  By dragging and dropping both the
‘File Save’ and ‘Print’ icons just

to the right of the ‘Browse’ icon, we can eliminate a couple
of superfluous vertical divider lines, leaving the Standard
Toolbar appearing as it does in the image to the right.  In
the  Categories  section  of  the  Customise  window,  select  ‘Image’,  and  from  the
Commands section of the Customise window, drag and drop ‘Image Information’ just

to  the  right  of  the  ‘Print’  icon,  to  make  the  Standard
Toolbar appear as it does in the image to the left.  In the
Categories section of the Customise window, select ‘View’,
and from the Commands section of the Customise window,

drag and drop in turn, just to the right of the vertical divider line, at the right-hand end
of the Standard Toolbar, the palette toggles for ‘Tool Options’, ‘Materials’, and ‘Layers’.



GRAPHICS FOR FLAG DESIGN --- 11 July 2024 --- Anne Onimous --- page 36

The Standard Toolbar should now appear as it does in the
image to  the  right.   There  are  several  tools  in  the  Tools
Toolbar  that  will  rarely  be of  use  to  mouse-wielding flag
designers, so in turn, drag and drop the icons for ‘Deform
Tool’, ‘Crop Tool’, ‘Clone Brush’, ‘Dodge Brush’, ‘Lighten/Darken Brush’, and ‘Picture

Tube Tool’ to the Customise window.  The Tools
Toolbar should now appear as it does in the image
to  the  left.   Click  the  ‘Pan  Tool’,  which  is
highlighted in pastel blue in the image to the left,

to reveal its drop-down menu item, the ‘Zoom Tool’.  Drag and drop the Zoom Tool just
to the right of the Pan Tool.  Be certain that you have only relocated the tool’s icon.  If
you accidentally also relocate a tool’s name to the Tools Toolbar, or if you make some
other mistake, select ‘Tools’ in the Categories section of the Customise window, and use
items as needed from the Commands section of the window to make corrections.

Move on to the ‘Selection Tool’,  and in turn drag and drop its  submenu items the
‘Freehand Selection’ tool and the ‘Magic Wand’ tool to the right of the Selection Tool.
Move on to  the  ‘Dropper  Tool’,  and drag  and drop its  sub-menu item the ‘Colour
Replacer Tool’ to the right of the Dropper Tool.  Move on to the ‘Paint Brush’ tool, and
drag and drop its sub-menu item the ‘Airbrush’ tool to the right of the Paint Brush tool.
Drag and drop its ‘Warp Brush’ tool to the Customise window.  Move on to the ‘Eraser
Tool’, and drag and drop its sub-menu item the ‘Background Eraser’ to the right of the
Eraser Tool.  You have now relocated all of the tools that were located in sub-menus.
Close the Customise window.  The drop-down arrows in the Tools Toolbar will be gone,
and the top of the PSP 8.10 window should appear as it does in the image below:

You should still have a New Image open.  Minimise it to the bottom of the PSP 8.10
window, and click the toggle icons for Tool Options, Materials, and Layers to obtain a
window that appear much like the one below.  Note that you can change the relative
vertical sizes of the Materials and/or Layers palettes by dragging their top edges.
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You will find that the Tool Options Palette can be docked at the top or at the bottom of
the PSP 8.10 design window, that the Materials and Layers Palettes can be docked at
any edge of the design window, and that all three can be made free-floating, as below:

Toggle all three floating windows out of view.  They will appear in the same states and
positions  when they  are  toggled  back  into  view,  whether  they  are  docked  or  free-
floating.  This will also be the case when the PSP 8 program is shut down and restarted.

Incidentally, if there is no image open in the PSP 8.10
window, and if you open the editor’s integrated image
browser, which is as brilliant a feature in PSP 8.10 as
it is in PSP 7.04 (or in PSP 9.01), you may notice that
the file menu changes slightly, but that ‘Context Help’
no longer appears.  No worries, you can fix that, yes?
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JASC PAINT SHOP PRO VERSION 9.01

(1) https://archive.org/details/Jasc_Paint_Shop_Pro_v9.01_Windows_2004_Eng  
(2) Download the 'ISO IMAGE' file (PSP9EN01.iso) to one of your folders.
(3) When the download is complete, navigate to the folder where you downloaded the
ISO file.  Right-click the file and select 'Open with > Windows Explorer'.  This should
place a virtual CD/DVD drive on your system, with a drive letter immediately above
those of  whatever  physical  drives  your  system may include.   The virtual  drive  will
remain on your system until the virtual CD is ejected or until your system is restarted.
The virtual  CD will  probably open to its  root  directory automatically,  but if  it  also
attempts to auto-install,  do not allow it to do so.  Instead just open the CD to its
root  directory,  but  do  not  click  autorun.exe.   (If  this  step  does  not  work  as
described, you can still burn the ISO to a physical CD or to a bootable thumb-drive.)
(4) From the root directory of the virtual CD, physical CD, or bootable thumb-drive,
open the 'PSP9' directory.  Again, do not click autorun.exe.
(5) From the PSP9 directory, open the ‘Paint Shop Pro 9’ directory.  Do not click
setup.exe.  Instead click  the  file  that  is  named 'Jasc  Paint  Shop Pro  9.msi'.   An
installation window should appear.
(6) Click 'Next' to see the licence agreement.  Select the 'I accept' bullet and click 'Next'.
(7) In the 'Customer Information' window that opens, fill in the spaces or leave them
blank, select an appropriate bullet for ‘Install this application for’, and click 'Next'.
(8) In the 'Custom Setup' window that opens, all options will be selected by default, as
illustrated below.  Leave them all selected and click ‘Next’.

In the ‘Ready to Install the Program’ window that appears, click ‘Install’.  When the
installation  is  complete,  an  ‘InstallShield  Wizard  Completed’  window  will  appear.
Select options in the window as you like, and click ‘Finish’.  A software registration
window will probably appear, and it may appear again when the software is first run.
Always click ‘Skip’, because no Jasc or Corel registration servers exist for this software.

When PSP 9.01 is first run, a ‘File Format Associations’ window will open, just as it did
for the first runs of PSP 7.04 and PSP 8.10.  If you have previously allowed one of those
programs to be the default graphics program to open some or all of the graphic file
types listed in the window, you may not  want  to  allow PSP 9.01  to  open them by
default.  You can always make changes later to the file format associations that you
have selected for each of the programs.  For now you may want to select ‘Remove All’,
and to  click  ‘OK’.   At  this  point  you may want  to  close or  minimise  the  PSP 9.01
window, to consider installing two other programs before learning more about PSP 9.

https://archive.org/details/Jasc_Paint_Shop_Pro_v9.01_Windows_2004_Eng
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Included with the Jasc PSP 9.01 ISO is the ability to install Jasc Animation Shop 3,
a good program that will allow you to make animated GIFs, should that sort of thing be
your cup of tea.  This is version 3.11, the last version of the program that Jasc produced
(Corel  did  not  make  further  revisions).   Animated  GIF  software  can  be  pricey,  so
providing such a program for free with Paint Shop Pro was yet another way in which
Jasc could tweak the noses of more greedy software providers.  Because the interface of
the program is modelled on that of Paint Shop Pro, getting around within it is easy.  Its
built-in ‘Help’ files are no longer supported, but Chapter four in the  “PSP 7 Getting
Started Guide”, available here or here, explains all of Animation Shop’s basic functions.

It is assumed that you still have the PSP 9 ISO opened as a virtual CD on your system,
following your installation of PSP 9.01.  When you first opened its ‘PSP9’ directory, you
probably noticed that besides its ‘Paint Shop Pro 9’ sub-directory there were two other
sub-directories named ‘Paint Shop Photo Album 5’ and ‘Animation Shop’.

In the Paint Shop Photo Album 5 sub-directory you will find a ‘Setup.exe’ file, with
which you can install  Jasc Paint Shop Photo Album 5.2.2, the final version that
Jasc ever made of this digital photo organisation/enhancement/presentation software.
It is a useful, well-made product that is yours for the taking.  No working ‘Help’ files.

In the Animation Shop sub-directory do not click setup.exe.  Instead click the file
that is named 'Jasc Animation Shop 3.msi'.   An installation window should appear.
Click  ‘Next’  to  see the  license agreement.   Select  ‘I  accept’  and click ‘Next’.   Make
entries as you like in the ‘Customer Information’ window and click ‘Next’.  Select the
‘Complete’ setup type and click ‘Next’.  In the ‘Ready to Install’ window, click ‘Install’.
When you first run the program, skip any registration and decide on any file format
associations.  If you have previously familiarised yourself with PSP 7.04, PSP 8.10, or
PSP 9.01, you will have little difficulty mastering  Jasc Animation Shop 3,  which
includes familiar tools and toggles, drag and drop toolbars, and preferences settings, as
well as a PSP-styled colour palette and an integrated image browser.  Explore, enjoy.     

We can now get back to JASC PAINT SHOP PRO VERSION 9.01, which on its
first run will have a default appearance much like that shown in the image below.

https://flagalternatives.com/wp-content/uploads/Jasc-Paint-Shop-Pro-7-Getting-Started-Guide.pdf
https://flagoptions.com/wp-content/uploads/Jasc-Paint-Shop-Pro-7-Getting-Started-Guide.pdf
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To kick off our closer look at PSP 9.01, we can make a few operations on a New Image
to ‘light up’ the default tools, palettes, and menus, as illustrated in the image below.
The default appearance of PSP 9.01 is much the same as for PSP 8.10, but note the new
‘History Palette’,  a useful feature that allows undo/redo operations on any previous
image operation, instead of only on the last image operation performed, as well as the
alternative type of colour picker ‘rainbow’ that has been added to the Materials Palette.
Other changes are less obvious, and will be spotlighted as this discussion continues.     

As previously mentioned, PSP 9.01 includes no animated Product
Tour,  but  those  for  PSP  7.04  and  PSP  8.10  remain  relevant.
Learning  resources  include  file  menu  ‘Help’
and  ‘Context  Help’,  as  well  as  an  expanded
‘Learning Centre’ palette, as illustrated to the
left.   Little  in  the  way  of  documentation  is
installed with PSP 9.01 by default, but one can
download  a  searchable  PDF  of  the  official,
502-page “Jasc Paint Shop Pro 9 User Guide”
from this old Jasc FTP site retained by Corel,
or alternatively either from here or from here.

Prior to further customisations it may be helpful to simplify the
default appearance of  the PSP 9.01 window as we did for PSP
8.10, by setting the file menu item ‘View > Toolbars’ to show only
the ‘Standard’,  ‘Status’,  and ‘Tools’  toolbars, and by setting the
menu item ‘View > Palettes’ to show no palettes for now.  We can
drag and drop the  Tools  Toolbar  to  the  right  of  the  Standard
Toolbar, leaving the top of the PSP 9.01 window as shown below.

Using the file menu item ‘File > Preferences > General Program
Preferences’,  we  can  open  the  ‘Paint  Shop  Pro  9  Preferences’
window.  Suggested settings for its nine tabs are on the next page.

https://flagalternatives.com/wp-content/uploads/Jasc-Paint-Shop-Pro-9-User-Guide.pdf
https://flagoptions.com/wp-content/uploads/Jasc-Paint-Shop-Pro-9-User-Guide.pdf
https://www.corel.com/6763/psp_downloads/pub/en/psp900enug.pdf
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If we use the file menu item ‘File > New’ (or if we click the ‘New’
tool  in  the  Standard  Toolbar),  we  can  open  the  ‘New  Image’
window.  Choose settings in the New Image window, or use those
suggested in the image to the right, and click ‘OK’.  With an active
image in the design window, the icons in the Standard Toolbar
and in the Tools Toolbar will now be active and easy to discern.  

By clicking the menu item ‘View > Customise’, we can open the
‘Customise’ window, and just as we did for PSP 8.10, we can now
use drag and drop operations to fully customise the file menu, the
Standard Toolbar, and the Tools Toolbar, as shown further below.
However, new features in PSP 9.01 allow us to add a ‘Show/Hide
History Palette’ toggle and four separate shape tools, which are the ‘Rectangle Tool’
(also makes squares), the ‘Ellipse Tool’ (also makes circles), the ‘Preset Shape Tool’
(with 89 unique shapes), and the new and very useful ‘Symmetric Shape Tool’ (makes
radially-symmetric polygonal or stellated shapes with three to one thousand ‘sides’).
There is also the option of adding an icon to launch Animation Shop 3, which can be
handy for users of both programs who may want to transfer images between them.
(Actually the ‘Launch Animation Shop’ icon is also usable in PSP 7.04 and in PSP 8.10.)

Also as in PSP 8.10, we can either dock the palettes or make them into free-floating
windows, as in the illustration above.  As mentioned earlier, the new History Palette
allows one to undo/redo previous image changes, rather than only the last change, and
it is also where one can clear an image’s complete or partial command history, so as to
reclaim memory.  (PSP 7 and PSP 8 did this from the file menu item ‘Edit > Empty’.)
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Besides either docking the palettes or free-floating them, as we can do in PSP 7.04 and
in PSP 8.10, we have a new feature in PSP 9.01 that gives us a third and very elegant
option of docking the palettes as barely intrusive ‘tabs’, as shown in the image below.
Hovering a mouse cursor over a tab will make its palette slide open, and the palette will
only remain visible while the cursor is within its borders, ‘rolling up’ when the cursor
moves away.  Alternatively, clicking a tab will make its palette slide open and remain
visible until the mouse is clicked somewhere else.  And there are even other options.

To learn more about the many palette docking options in PSP 9.01, use the file menu
item ‘Help > Help Topics > What’s New in Paint Shop Pro 9’, as illustrated below.

Whilst you are there, you can also learn all about the great new Symmetric Shape Tool
in PSP 9.01, which is a real improvement on the shape-making abilities of PSP 7 and 8.
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Consider,  for  example,  the  seven-pointed  Australian  Commonwealth
Star, which appears in five places on the Australian national flag.  As all
Aussies know, six of the points on the Commonwealth Star symbolise
Australia’s six states, whilst the seventh point represents the nation’s ten
territories.  The ‘Preset Shapes’ tool in PSP 7.04 and in PSP 8.10 only
offers four, five, six, and eight-pointed star shapes, so using either of

those versions of Paint Shop Pro to make a seven-pointed star can be a bit of a mission,
but with the Symmetric Shape Tool in PSP 9.10, a perfect seven-pointed star is but a
few clicks away, and that was all the effort that was required to make the image top left.

Prior to its acquisition by Corel, Jasc made a small software patch available for PSP
9.01, and it can still be obtained from the old Jasc FTP server files that Corel maintains
at  https://www.corel.com/6763/psp_downloads/pub/update/, or from the same FTP
server files that are preserved on an Internet Archive website that can be found here.
On visiting either  website,  note  that  the  eighth file  listed  is  ‘en_psp9011_jasc.exe’.
When run,  this  small  patch file  will  update several  of  the  PSP 9.01  Dynamic Link
Library (DLL) files from version 9.0.1.0 to version 9.0.1.1.  What bugs the patch fixes,
or what performance improvements it may provide, are anyone’s guess, but it is safe to
assume that  it  does  something beneficial,  and that  it  is  therefore  worth installing.
However, one cannot simply click on the patch file to download it.  Instead one must
either  copy and paste  its  name,  or  manually  type its  name,  directly  after  the  final
forward slash in the webpage URL address, as illustrated in the image below.

Hitting ‘Enter’ will then replace the FTP webpage with a download window . . .

. . . from which the executable patch file can be saved to a selected location and opened.

https://web.archive.org/web/20170227172119/https://www.corel.com/6763/psp_downloads/pub/update/
https://www.corel.com/6763/psp_downloads/pub/update/
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PSP 9.01 must be fully shut down during the patch, including its background files, so a
system restart may be required before the patch will successfully run to completion.

By the way, all of the subdirectories at https://www.corel.com/6763/psp_downloads/,
as well as all of the subdirectories of those subdirectories, have been carefully explored
to glean everything useful for Jasc PSP 7/8/9, for Jasc Animation Shop 3, and for Jasc
Paint Shop Photo Album 5, including relevant documentation.  There is no listing for a
PDF version of the Jasc Paint Shop Pro 7 User Guide, and there are no official Jasc
patches for PSP 7.04 or PSP 8.10, nor any official Jasc patch to upgrade PSP 9.01 to
PSP  9.02,  the  final  Jasc  version  of  PSP  9  that  is  referenced  on  Wikipedia  and
elsewhere, but which probably never existed.  Persons who search for such things on
the Internet may find websites that claim to offer them, but that actually offer malware.

In addition to the lack of any update file for Jasc Paint Shop
Pro 9.02 on either Corel or Jasc FTP servers, addition evidence
that it probability never existed can be found from the version
of PSP 9 that Corel distributed in 2005, using its own branding
on both the packaging of the software and on the label of its
installation CD.  Arguing against the existence of the version is
the  fact  that  the  Corel-branded  software  shown  left  installs
version 9.0 of Jasc Paint Shop Pro, not 9.02, nor even 9.01.
The  trustworthy  third-party  update  website  oldversion.com,
at  http://www.oldversion.com/windows/paint-shop-pro/, also
lists no version 9.02 update file.  A few of the DLL files that are
installed by PSP 9.01 are in fact version 9.0.2.0, but given that
most  of  them  are  version  9.0.1.0,  and  given  that  even  the
previously mentioned patch only updates a few of the DLL files
to  version  9.0.1.1,  the  existence  of  the  few that  are  version
9.0.2.0 only implies that Jasc may have had plans to eventually
update PSP 9.01 to PSP 9.02, and not that those plans ever
came to fruition after Corel’s acquisition of the company.  Rest
assured, however, that the author of this document will keep
an open mind on the subject, and will continue to search for
such an update.  If eventually one can be found to download, a
link to it will be provided in a future revision of this document.

One can open multiple  instances  of  any or  all  of  the  PSP versions that  have  been
discussed  here,  which  can  sometimes  prove  useful,  perhaps  especially  for  multi-
monitor systems or for those that use virtual desktops, when copy and paste operations
between running instances of Paint Shop Pro may afford some advantage, for example,
but whether the amount of system memory that is available for each instance remains
the same, or is reduced, is beyond the ken of the author of this document.  However, if
memory does run short, one temporary remedy is to go to the Windows Task Manager,
expanding its details if needed to access its ‘Processes’ tab.  One can then right-click
any running process of Paint Shop Pro and select ‘Go to Details’.  By right-clicking the
Paint Shop Pro listing on the ‘Details’ tab, one will have the option of elevating the ‘Set
priority’ setting from its default of ‘Normal’ to ‘Above normal’, ‘High’, or ‘Realtime’.

All of the versions of Paint Shop Pro that are described here can also make use of
‘Adobe-compatible plug-ins’, although the author of this document knows of none to
recommend.  Using the file menu item ‘File > Preferences > File Locations’ will open a
window in which locations and certain options for such plug-ins can be specified.  Also

http://www.oldversion.com/windows/paint-shop-pro/
https://www.corel.com/6763/psp_downloads/
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available in the window will  be a place to specify the ‘Web Browsers’  that one can
theoretically call from within the Paint Shop Pro software, although probably only for
websites that no longer exist.  The Web browser that is listed by default is Microsoft’s
Internet Explorer, which is now defunct, so users may want to delete it, and to instead
list paths to whatever browsers they may use.  For the Firefox Web browser this will
typically be ‘C:\Program Files\Mozilla Firefox\firefox.exe’, and for Microsoft Edge it
will typically be ‘C:\Program Files (x86)\Microsoft\Edge\Application\msedge.exe’.

JASC WEBDRAW VERSION 1.02 (a Jasc graphics editor for SVG files)

In 2002, when SVG was still  a  nascent vector image file format, the minds at Jasc
Software produced one of the first graphics editing software products that could make
use of it, which they called WebDraw.  Although Jasc WebDraw got some good press,
and although it advanced from version 1.00 to version 1.02, it did not have much time
to firmly catch on before the 2004 sale of  Jasc Software to the Corel  Corporation.
Corel’s flagship product is CorelDRAW, a vector graphics editor that competes with
Adobe Illustrator, so when Corel bought Jasc, they summarily killed off Jasc WebDraw.

Still, as a product with the ability to not only open and save SVG files but to create
them, and with a user interface that is based as much as possible on that of Paint Shop
Pro, Jasc WebDraw 1.02 is definitely a graphics editor that flag designers should be
aware of.  Although not as customisable as Paint Shop Pro 8 or 9, WebDraw can still
have visible or hidden toolbars and palettes, and they can be docked or free-floating.
The default appearance of the product when it is first installed, as depicted above, can
easily be changed to something more suitable for flag design, as shown on the following
page, where the fully functional, integrated ‘Help’ file system has also been illustrated. 
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Commercially-sold versions of Jasc WebDraw that included an installation
CD were apparently so rare that few if any have ever shown up for sale on
Ebay or on similar websites.   All  that  can be found on the old Jasc FTP
servers are two patch files for updating the purchased version, as well as a
file to install a time-limited, ‘try-and-buy’ evaluation copy of WebDraw 1.02.

A previous version of this document informed readers of how to install the evaluation
version of Jasc WebDraw 1.02 in such a way that it would probably not expire, but a
regular, full-installation version of WebDraw 1.01 was later found, and it has now
been  made  available  for  download.   Once  installed  it  can  be  updated  to  Jasc
WebDraw  1.02  by  using  an  official  patch  file,  which  has  been  included  with  the
download.  Instructions follow for downloading, installing, and updating the official,
regular  version  of  WebDraw.   Readers  who  previously  installed  the  evaluation
version should fully uninstall it before installing and updating the regular version.

(1) Go to https://archive.org/details/jasc-web-draw-1 and download the ‘ISO IMAGE’
file (JascWebDraw1.iso) to a folder on your Windows system.
(2) When the download is complete, navigate to the folder where you downloaded the
ISO file.  Right-click the file and select 'Open with > Windows Explorer'.  This should
place a virtual CD/DVD drive on your system, with a drive letter immediately above
those  of  whatever  physical  drives  your  system  may  include.   The  virtual  CD  will
probably open to its root directory automatically, but if it also attempts to auto-install,
do not allow it to do so.  Instead just open the CD to its root directory.  Be certain
that  you  do not run jwdw1.exe.   If  you accidentally  run jwdw1.exe,  initiating  a
conventional installation of the Jasc WebDraw software, just cancel the installation. 
(3) Copy  the  jwdw1.exe  file  to  a  folder  on your  system.   Do not run it  as it  is.
Instead, extract, unpack, or unzip its component files into the new folder ‘jwdw1’, using
file archiving/extraction software such as the free  7-Zip utility.  Open the new folder
but do not click setup.exe.  Instead click the file ‘Jasc WebDraw 1.0 ESD.msi’, and
follow the instructions to fully install the software with its optional sample files, as well
as the Adobe SVG Web viewer plug-in.  Skip registration, and shut the program down.
(4) Return to the root directory of the virtual CD and open the sub-directory that is
labelled ‘Patch v1.01 to v1.02’.  Run the file ‘wdw102ep.exe’ to patch WebDraw to v1.02.
(5) Once the patch is complete, eject the virtual CD from your system.

For a very rudimentary overview of Jasc WebDraw features, go to this archived website
and step in turn through the remaining ‘overview’ webpages that have been provided
there.  The old Jasc FTP servers that Corel maintains do not contain a user guide PDF
for Jasc WebDraw, nor will any such PDF will be found amongst its installation files.
Its built-in ‘Help’ files are good, though, and they often include ‘context-sensitive’ help
for any currently selected tool or element by pressing one’s keyboard F1 function key.
Additional  helpful  information  can  be  found  in  this  third-party  overview/tutorial,
which  can  also  be  downloaded  from  this  alternate  location.   The  third-party
overview/tutorial references some of the eight sample files that are installed by default
with Jasc WebDraw.  The sample files are typically located at ‘C:\Program Files (x86)\
Jasc Software Inc\WebDraw 1\Sample Files’.  A basic SVG tutorial can be found here,
and comprehensive information about the SVG file format can be found  here.  For
those users who want to deeply explore all that SVG can offer, two of the three books
that Jasc recommended on the subject are free to read at Books to Borrow.
They are "Sams Teach Yourself SVG in 24 Hours" and “SVG Essentials”.  The
third book, "Designing SVG Web Graphics", a one-kilogram tome that Jasc
sold on its website, can often still be bought new or used from various sellers.

https://archive.org/details/svgessentials0000eise_k1h3
https://archive.org/details/samsteachyoursel0000laak
https://www.w3.org/TR/SVG/
https://www.w3schools.com/graphics/svg_intro.asp
https://flagalternatives.com/wp-content/uploads/An-Excerpt-from-SVG-for-Web-Developers-about-Jasc-WebDraw.pdf
https://flagoptions.com/wp-content/uploads/An-Excerpt-from-SVG-for-Web-Developers-about-Jasc-WebDraw.pdf
https://web.archive.org/web/20030803044547/http://www.jasc.com/products/webdraw/design.asp
https://www.7-zip.org/index.html
https://archive.org/details/jasc-web-draw-1
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However, there is a free and arguably better way to obtain
Designing SVG Web Graphics.  Go to the website depicted
to the left, complete the ‘I am human’ Captcha, and click
the ‘Download Original PDF’ button.  Download the file
‘vdoc.pub_designing-svg-web-graphics.chm’ to a folder on
your Windows system.  This is a standard CHM Windows
‘Help’  file  that  contains  the  entire,  592-page  content  of
Designing SVG Web Graphics, but in a format that unlike
any printed book has hyperlinks and is fully searchable.

The SVG vector imaging format was invented by Web developers, for Web developers,
but that does not prevent it from being used by aspiring flag designers in ways that are
unrelated to Web graphics, and without a firm grasp of its Web-related underpinnings.
Still, a basic grasp of a few things will probably help new users of WebDraw, especially
if they have only had prior experience with raster graphics editors like Paint Shop Pro.

The first thing to point out is that the SVG image format is really not an ‘image’ format
at all, but rather a ‘document’ format.  SVG files are actually just text files that are
written in  a  special  sub-format  of  Extensible  Markup Language (XML),  which is  a
‘coding’ standard that the World Wide Web Consortium (W3C) introduced in 1998.  In
order to be presented as visual images, the textual ‘source code’ of ‘SVG documents’
must be ‘interpreted’ by a ‘rendering engine’, or in other words by a graphics editor
that can display SVG images, such as WebDraw.  In  Designing SVG Web Graphics
there is an example of such SVG source code, as illustrated to the left below.  If this
code is copied and pasted into the ‘Source’ tab of a new WebDraw image (document), a
corresponding ‘Canvas’ tab image will be rendered, as illustrated to the right below.

<?xml version="1.0" standalone="no"?>
<!DOCTYPE svg PUBLIC "-//W3C//DTD SVG 1.0//EN"
      "http://www.w3.org/TR/2001/PR-SVG-20010719/
       DTD/svg10.dtd">
<svg width="400" height="500">
<defs>
 <filter id="Turbulence1"
filterUnits="objectBoundingBox">
  <feTurbulence type="turbulence" baseFrequency="0.01"
   numOctaves="1" seed="0" >
  </feTurbulence>
 </filter>
</defs>
<rect x="0" y="0" width="400" height="500"
style="filter:url(#Turbulence1)"/>
</svg>

https://vdoc.pub/download/designing-svg-web-graphics-7lq3pt0iiuj0
https://vdoc.pub/download/designing-svg-web-graphics-7lq3pt0iiuj0
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During the exercise on the previous page, if we have docked the
WebDraw ‘Properties Palette’, ‘Document Object Model Palette’,
and ‘Overview Window’ at the right side of the WebDraw graphics
window, they will appear as they do in the illustration to the right.
In the SVG ‘vernacular’, every graphic item that one generates in a
Jasc  WebDraw  Canvas  tab  is  an  ‘object’.   Objects  in  Jasc
WebDraw are roughly analogous to layers in Jasc Paint Shop Pro.
Like  layers,  objects  can  be  rearranged  either  upwards  or
downwards,  and  they  can  also  be  merged  (or  ‘un-merged’),
although  in  WebDraw  the  terms  are  ‘grouped’  or  ‘ungrouped’.
Also like layers, objects can be manipulated in various ways, some
of them having no PSP analogues.     

Thus the WebDraw Document Object  Model  (‘DOM’) Palette is
roughly analogous to the Layers Palette in Paint Shop Pro 8 and 9.
Moreover, each object in an SVG document can have individual
properties, such as dimensions, colour, and visibility, making the
WebDraw Properties Palette  roughly analogous to the Materials
Palette in Paint Shop Pro 8 and 9.  As illustrated to the right, the
content of the Properties Palette will change in accordance with
whatever object is currently selected in the DOM Palette, and by
the same token will also allow changes to be made to that object.

Because  SVG  is  a  text-based  graphics  format,  if  one  were  to
become  completely  fluent  in  its  XML-format  source  coding
language,  one  could  actually  design  a  flag  using  nothing  more
than a text editor, even one as ordinary as the Windows Notepad.
Of course there are text editors that are much better suited to the task, such as the free
and excellent Notepad++, as well as text editors that have been specifically tailored to
all of the needs of XML source coding.  However, it will usually be easier and less error-
prone to use a graphics editor with a user interface that will automatically generate the
source  code  from objects  that  have  been built  graphically.   In  Jasc  WebDraw,  for
example,  the user  constructs  objects  in  the  Canvas  tab of  the SVG image window,
arranging  and  otherwise  modifying  them  as  desired,  and  WebDraw  automatically
generates the corresponding source code in its Source tab.  The XML-based text of the
source code can then be copied for integration into HTML-based Web pages, although
this WebDraw feature will be more attractive to a Web designer than to a flag designer.

As can be seen from the example above, a few lines of simple text, comprising a very
small file size, can equate to a very complex graphic image, and one that can be scaled
to any size without degradation.  These of course are a few of the previously-mentioned
advantages that vector images can sometimes have over raster images, especially since
vector images can always be converted, when needed, to raster images.  Note that Jasc
WebDraw, for example, can ‘export’ SVG vector image files as compressed JPEG (.jpg)
raster image files or as uncompressed BITMAP (.bmp) raster image files.  Of particular
interest  to flag designers,  also as  previously mentioned, is  that SVG files  are often
suitable,  just  as  they  are,  for  flag  manufacturers  to  use  when making actual  flags.
Other common graphic file formats that flag manufacturers prefer are PDF and PSD.
Like Jasc Paint Shop Pro 7, 8, and 9, Jasc WebDraw cannot directly save or export SVG
files as PDF files, but third-party converters are available, such as this one.  Unlike Jasc
Paint Shop Pro 7, 8, and 9, Jasc WebDraw cannot directly save or export SVG files as
PSD files, but third-party converters are again available, such as this one.  One should

https://www.freeconvert.com/svg-to-psd
https://www.freeconvert.com/svg-to-pdf
https://notepad-plus-plus.org/
https://notepad-plus-plus.org/
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also note  that  Windows includes  a  ‘virtual’  printer  called ‘Microsoft  Print  to  PDF’,
which can generate a PDF of any image, including the images of any Jasc product.
Print to PDF only accommodates standard paper sizes, not as ideal as generating a PDF
with the exact dimensions of a given image, but there are ways of dealing with this, too.

Jasc WebDraw is bit dated, and it is also a bit glitchy, but it can nevertheless serve as a
great introduction to vector imaging for aspiring flag designers.  If they do not care for
its Web-related features (including SVG animation, by the way), they can safely ignore
them, and never even glance at the Source code tab or at the Adobe Web Preview tab
on their SVG image window, but only at its Canvas tab, as they fill it with the objects
that will comprise their flag designs.  They can also use WebDraw as a ‘stepping stone’
to far more feature-rich vector graphics editors such as Inkscape.  Before that, though,
they should at least muck about a little with all of WebDraw’s eight sample images:

https://www.propdf.com/resize-pdf
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This document will end by saluting yet another old Jasc product that is suitable for use
by flag designers, although it probably cannot be installed for free, but only with a ‘key’.

So pick your poison.  Start designing flags.  And be sure to read and download: 
“Good Flag, Bad Flag is Rubbish” and “When Vexillologists are Vexations”

https://flagoptions.com/wp-content/uploads/When-Vexillologists-are-Vexations.pdf
https://flagoptions.com/wp-content/uploads/Good-Flag-Bad-Flag-is-Rubbish.pdf

